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Preface
The Forte 4GL Java Interoperability Guide explains how you use Common Object Request 
Broker Architecture (CORBA) to write objects that interact transparently with other remote 
objects that are written in different languages and run on different operating systems and 
hardware.
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Organization of This Manual
This manual begins with a brief overview of CORBA architecture and the support provided 
by Forte 4GL and then it provides a more detailed discussion of the tasks involved in 
creating CORBA servers and Clients. Briefly, the chapters are:

Chapter Description

Chapter 1, “Interoperating With CORBA Objects” Provides an overview of the CORBA architecture and the 
TOOL libraries and utilities that you use to support it.

Chapter 2, “CORBA Servers” Provides an overview of CORBA servers and then examines 
a Java and TOOL server implementation as examples. 

Chapter 3, “Working with CORBA Clients” Provides an overview of CORBA clients and then examines 
a Java and TOOL client implementation as examples. 

Appendix A, “IDL and TOOL” Describes the mapping between IDL types and TOOL types, 
and between TOOL types and IDL types.

Appendix B, “Using Fscript to Configure CORBA 
Servers”

Gives detailed information for script writers about the 
settings you can use with service objects that are acting as 
CORBA servers.
Forte 4GL Java Interoperability Guide
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Conventions
This manual uses standard Forte documentation conventions in specifying command 
syntax and in documenting TOOL code.

Command Syntax Conventions
The specifications of command syntax in this manual use a “brackets and braces” format. 
The following table describes this format: 

TOOL Code Conventions
Where this manual includes documentation or examples of TOOL code, the TOOL code 
conventions in the following table are used. 

Format Description

bold Bold text is a reserved word; type the word exactly as shown.

italics Italicized text is a generic term that represents a set of options or values. Substitute an 
appropriate clause or value where you see italic text.

UPPERCASE Uppercase text represents a constant. Type uppercase text exactly as shown.

underline Underlined text represents a default value. 

vertical bars | Vertical bars indicate a mutually exclusive choice between items. See braces and brackets, 
below.

braces { } Braces indicate a required clause. When a list of items separated by vertical bars is enclosed in 
braces, you must enter one of the items from the list. Do not enter the braces or vertical bars.

brackets [ ] Brackets indicate an optional clause. When a list of items separated by vertical bars is enclosed 
by brackets, you can either select one item from the list or ignore the entire clause. Do not 
enter the brackets or vertical bars.

ellipsis … The item preceding an ellipsis may be repeated one or more times. When a clause in braces is 
followed by an ellipsis, you can use the clause one or more times. When a clause in brackets is 
followed by an ellipsis, you can use the clause zero or more times. 

Format Description

parentheses ( ) Parentheses are used in TOOL code to enclose a parameter list. Always include the parentheses 
with the parameter list.

comma , Commas are used in TOOL code to separate items in a parameter list. Always include the 
commas in the parameter list.

colon : Colons are used in TOOL code to separate a name from a type, or to indicate a Forte name in a 
SQL statement. Always include the colon in the type declaration or statement.

semicolon ; Semicolons are used in TOOL code to end a TOOL statement. Always type a semicolon at the 
end of a statement.
Preface
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The Forte Documentation Set
Forte produces a comprehensive documentation set describing the libraries, languages, 
workshops, and utilities of the Forte Application Environment. The complete Forte Release 
3 documentation set consists of the following manuals in addition to comprehensive 
online Help.

Forte 4GL
■ A Guide to the Forte 4GL Workshops

■ Accessing Databases

■ Building International Applications

■ Escript and System Agent Reference Manual

■ Forte 4GL Java Interoperability Guide

■ Forte 4GL Programming Guide

■ Forte 4GL System Installation Guide

■ Forte 4GL System Management Guide

■ Fscript Reference Manual

■ Getting Started With Forte 4GL

■ Integrating with External Systems

■ Programming with System Agents

■ TOOL Reference Manual

■ Using Forte 4GL for OS/390

Forte Express
■ A Guide to Forte Express

■ Customizing Forte Express Applications

■ Forte Express Installation Guide

Forte WebEnterprise and WebEnterprise Designer
■ A Guide to WebEnterprise

■ Customizing WebEnterprise Designer Applications

■ Getting Started with WebEnterprise Designer

■ WebEnterprise Installation Guide
Forte 4GL Java Interoperability Guide
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Forte Example Programs
In this manual, we often include code fragments to illustrate the use of a feature that is 
being discussed. If a code fragment has been extracted from a Forte example program, the 
name of the example program is given after the code fragment. If a major topic is 
illustrated by a Forte example program, reference will be made to the example program in 
the text.

These Forte example programs come with the Forte product. They are located in 
subdirectories under $FORTE_ROOT/install/examples. The files containing the examples 
have a .pex suffix. You can search for TOOL commands or anything of special interest with 
operating system commands. The .pex files are text files, so it is safe to edit them, though 
you should only change private copies of the files. 
Preface
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Viewing and Searching PDF Files
You can view and search 4GL PDF files directly from the documentation CD-ROM, store 
them locally on your computer, or store them on a server for multiuser network access. 

Note You need Acrobat Reader 4.0+ to view and print the files. Acrobat Reader with Search is 
recommended and is available as a free download from http://www.adobe.com. If you do 
not use Acrobat Reader with Search, you can only view and print files; you cannot search 
across the collection of files.

� To copy the documentation to a client or server:

1 Copy the fortedoc directory and its contents from the CD-ROM to the client or server 
hard disk.

You can specify any convenient location for the fortedoc directory; the location is not 
dependent on the Forte distribution.

2 Set up a directory structure that keeps the fortedoc.pdf and the 4gl directory in the same 
relative location.

The directory structure must be preserved to use the Acrobat search feature.

Note To uninstall the documentation, delete the fortedoc directory.

� To view and search the documentation:

1 Open the file fortedoc.pdf, located in the fortedoc directory.

2 Click the Search button at the bottom of the page or select Edit > Search > Query.

3 Enter the word or text string you are looking for in the Find Results Containing Text field 
of the Adobe Acrobat Search dialog box, and click Search.

A Search Results window displays the documents that contain the desired text. If more 
than one document from the collection contains the desired text, they are ranked for 
relevancy.

Note For details on how to expand or limit a search query using wild-card characters and 
operators, see the Adobe Acrobat Help.

4 Click the document title with the highest relevance (usually the first one in the list or 
with a solid-filled icon) to display the document.

All occurrences of the word or phrase on a page are highlighted. 

5 Click the buttons on the Acrobat Reader toolbar or use shortcut keys to navigate 
through the search results, as shown in the following table: 

6 To return to the fortedoc.pdf file, click the Homepage bookmark at the top of the 
bookmarks list.

7 To revisit the query results, click the Results button at the bottom of the fortedoc.pdf 
home page or select Edit > Search > Results.

Toolbar Button Keyboard Command

Next Highlight Ctrl+]

Previous Highlight Ctrl+[

Next Document Ctrl+Shift+]
Forte 4GL Java Interoperability Guide



Chapter 1
Interoperating With
CORBA Objects
Using Common Object Request Broker Architecture (CORBA) you can write objects that 
interact with remote objects without your needing to be concerned about where the 
objects are located, what language they are written in, or how they perform their tasks.

Using the Forte Workshop, you can include libraries that provide CORBA support and you 
can create projects that contain classes whose methods request operations on external 
objects. These classes are stored in the repository and used in TOOL just like any other 
class.

This chapter provides a brief overview of the CORBA architecture and the TOOL libraries 
and utilities that you use to support this architecture. 
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Overview
CORBA is a standard distributed object architecture that allows application components 
written by different vendors to interoperate across networks and operating systems. 
Objects that interoperate in this way are called CORBA objects. These objects can be 
written in different languages; they communicate by using the Interface Definition 
Language (IDL), which defines their interfaces.

CORBA Architecture and Concepts
The CORBA architecture and concepts introduced in this section are defined in the 
CORBA/IIOP 2.0 Specification. This section provides a brief overview of this material.

Basic Concepts
An application using CORBA’s architecture to allow objects, written in different languages 
and hosted on different operating systems and machines, to interoperate consists of the 
following components:

■ A client: the code where a method invocation originates. A client uses an ORB to access 
services from the ORB of the server. (Clients can also be referred to as CORBA clients or 
IIOP clients.)

■ An object implementation: the code that receives the method invocation; it is part of a 
local or remote server. Each object implementation has a unique object reference that 
the client uses to find the object and invoke its methods. (An object implementation 
can also be referred to as a CORBA object.)

The object implementation or CORBA object is part of a server that uses an ORB to 
provide services to a client.

■ An IDL (Interface Definition Language) file: a text file containing IDL statements that 
specify the interface to an object implementation. The IDL interface definition is 
independent of any single programming language, but maps to all of the popular 
programming languages, using standardized mappings for Java, C++, C, COBOL, 
Smalltalk, Ada, Lisp, Python, and IDLscript.

The IDL interface defines the object’s type, specifies the signatures of the methods that 
the object implements, and specifies the exceptions that the methods return. Both the 
client and the server must compile this text file, which generates an IDL stub file, an IDL 
skeleton file, and other files required for CORBA support.

■ An IDL stub file, or stub, is used by the client. It translates the object implementation’s 
interface from a language-neutral format the client’s implementation language. The 
stub files contain generated code that handles the marshalling of method invocations 
into a form that can be transmitted over the wire.

■ An IDL skeleton file, or skeleton, is used by the server. It maps the language-neutral 
form of the CORBA object’s interface to the language in which the CORBA object is 
implemented. The skeleton files contain generated code that turns requests coming in 
over the wire into the format expected by the server.

Depending on how you develop the server, you can either write your own IDL file or 
have the 4GL runtime create one for you at partitioning time. For more information, see 
“TOOL Servers” on page 31.

For more information about the OMG Interface Definition Language (IDL), see Interface 
Description Language: Definition and Use” by Richard Snodgrass, Computer Science 
Press, 1989 or Chapter 3 of the Common Object Request Broker: Architecture and 
Specification Revision 2.2.
Forte 4GL Java Interoperability Guide
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■ An ORB (Object Request Broker): the communication infrastructure supplied by the 
vendor for a particular run-time system. ORBs use CORBA 2.0 and IIOP to serve as 
middleware for the client and server. They find the object implementation, they 
package a method call as a message, they interpret the message as a method call (for the 
server), and they enable the server to invoke the correct method on the correct object 
and pass any return values back to the client. Forte 4GL has a built-in ORB.

■ An IOR (Interoperable Object Reference) file: a file provided by the server. The file 
contains an IOR string that can be interpreted by the client’s ORB to locate and bind to 
a particular object implementation. If you use the naming service to get an object 
reference, you do not need to create or use this file. For more information, see “Getting 
an Object Reference” on page 16.

Architecture
Figure 1 shows how the entities described in the previous section work together to allow 
distributed objects to interoperate.

Figure 1 CORBA Architecture

Having obtained an object reference for the object, the client uses the reference to invoke a 
method on the object. The client uses the same code it would use if this were a local 
method call, but substitutes the object reference for the class instance name. If the object 
implementation is remote, the object reference points to a stub, which uses the ORB to 
forward the invocation to the object. The stub uses the ORB to identify the machine where 
the object is running and asks that machine’s ORB for a connection to the object’s server. 
The stub then sends the object reference and actual parameters to the skeleton code that is 
linked to the remote object. The skeleton transforms the call and parameters into the 
format expected by the CORBA object, and calls the method. Any results or exceptions are 
returned along the same path.

Although you do need to generate the stub and skeleton from the IDL file that describes the 
object’s interface, and to obtain the object reference, you do not have to concern yourself 
with how the stubs, skeleton, and ORBs work together to enable transparent 
communication. 
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Getting an Object Reference
Before a client can call a CORBA object, it must obtain a reference to the object. An object 
reference is an opaque structure that identifies the CORBA object’s host machine and the 
port on which the host server is listening for requests. The object reference also contains a 
key that identifies the actual object on the server. Having obtained the object reference, the 
client can then invoke a method on the object by using that reference.

The client can get an object reference in one of two ways: using the naming service or using 
an IOR file. 

■ The client can start a COS-compliant (Common Object Services) naming service and 
call an ORB method that resolves a name into an object reference. (In this case, the 
server has already registered the object implementation with the naming service.) For 
more information see “Using the Naming Service” on page 46.

■ The server uses an ORB method to create a string from an object reference; the server 
can then write the object reference to an IOR file and the client can read the file and call 
another ORB method to convert the string to an object reference. For more information, 
see “Using an IOR File to Pass an Object Reference” on page 34.

■ At partitioning time, the server developer can mark the service object as a CORBA object 
and then use the ensuing IIOP Configuration dialog to specify the name of an IOR file. If 
this option is used, the 4GL runtime creates an IOR file for the client’s use either at 
runtime or when the application distribution is made. The client can then use an ORB 
method to turn the IOR string into an object reference. 

This is similar to the second method except for the fact that the IOR file gets generated 
automatically and offers the option to configure a server in a suitable way if there is a 
firewall. For more information, see “Specifying that a Service Object Is a CORBA Server” 
on page 34.

Using the first method is recommended for intranet interoperability, using the last two 
methods is preferable for situations in which multiple external clients are accessing one or 
more servers across a firewall.

Naming Service
If the ORB vendor provides a CORBA COS Naming Service, it will be organized as a tree-like 
directory or namespace for object references. The namespace is organized like a file system 
that provides directories in which to store files. The root of the namespace is called the 
initial naming context; subdirectories in the name space are called naming contexts. When 
you store an object reference in a naming context, you associate it with an advertise name 
and the object reference-name pair is called a name binding.

ORB vendors often provide an implementation of the CORBA COS Naming Service. A 
server can use the naming service to register the CORBA objects it wants to advertise; the 
client can use the naming service to obtain a reference for the CORBA objects whose 
methods it wants to call. You must explicitly start the naming service and assign it a port 
number before clients or servers can use it.

For additional information on how to use the naming service to obtain an object reference, 
see the code examples shown in Chapter 2 and Chapter 3 of this manual.
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CORBA Support
TOOL support for CORBA is, for the most part, integrated into the 4GL runtime system. In 
addition to the system support, the 4GL product also supplies the following:

■ Corbagen, a utility that generates an IDL-to-TOOL mapping from an IDL text file, and 
that also generates the stub, skeleton, and other helper classes needed for CORBA 
support.

■ The CosNaming library, a library that supplies the classes you need to access and use a 
naming service.

■ The CORBA library, which provides the ORB class, the TOOL interface CorbaObject 
(which maps to the IDL type object), and the CorbaObjectImpl class, which is the root 
class for all CORBA classes.

You can use Forte’s CORBA support to create a TOOL server that can interoperate with non-
TOOL clients or to create a TOOL client that can interoperate with non-TOOL servers. The 
examples given in this book focus on TOOL-Java interoperability, but you can use the TOOL 
Corba library and the built in runtime support to communicate with any other ORB-
enabled client or server.

CORBA and CosNaming interface specifications are currently published at the following 
locations:

■ ftp://ftp.omg.org/pub/docs/formal/97-12-10.pdf 

■ ftp://ftp.omg.org/pub/docs/formal/97-12-10.ps

The TOOL Corba Library
The table below describes the contents of the TOOL Corba library.

Name Superclass Description

CorbaObject Interface Provides the mapping to the IDL type Object. Any object that 
can be passed as a parameter of type Object or that can be 
received as a return type or output parameter whose declared 
type is Object needs to implement the CorbaObject interface. 
This applies to any object using the naming service. Any classes 
that inherit from CorbaObjectImpl automatically implement 
this interface.

CorbaObjectImpl Object Implements CorbaObject. Recommended as base class for all 
TOOL classes that are used with CORBA. CorbaObjectImpl is 
returned for a return value or output parameter when its 
declared IDL type is Object and if the actual type returned is not 
known in the current project. When the return type is Object in 
IDL and CorbaObject in TOOL users should always use 
ORB.narrow to make sure they get an object of the desired 
type. CorbaObjectImpl is mapped to Framework::Object in IDL.

ORB Object A class providing APIs for the CORBA Object Request Broker 
features. 

--Initializes the ORB implementation by supplying values for 
predefined properties and environmental parameters 

--Obtains initial object references to services such as the 
Naming Service using the method resolve_initial_references 

--Converts object references to strings and back 

BAD_OPERATION SystemException Exception class that is raised by certain ORB operations.

BAD_PARAM SystemException Exception class that is raised by certain ORB operations.

InvalidName UserException Exception class that is raised by certain ORB operations.
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The CosNaming Library
The table below describes the contents of the TOOL CosNaming library.

Using ORB Development Tools
You typically use an ORB development tool to develop the non-TOOL client or server that 
communicates with a TOOL client or server. Although Forte 4GL supports ORB products 
supplied by both Visigenic and Iona, this manual does not provide product-specific 
information about using them. You can find this information in the following Technical 
Notes:

■ Using Visigenic VisiBroker for Java with Forte 4GL

■ Using Iona OrbixWeb with Forte 4GL.

You can access the Forte Technical Notes either through the Forte web site 
http://www.forte.com/support/technotes.html) Tech Info pages, or by calling Forte 
Technical Support.

Name Superclass Description

Binding Object A class that represents the association of a name with an 
object. The naming context is populated by one or more 
bindings.

BindingIterator CorbaObjectImpl A class whose methods allow you to iterate through all 
bindings in the naming service.

NameComponent Object A class that provides the structure of the name hierarchy.

NamingContext CorbaObjectImpl A class that you use to associate a name with an object 
reference, to obtain an object reference from a given name, 
and to create or destroy nodes in the naming service hierarchy.

AlreadyBound UserException Exception class that is raised when you are trying to register a 
name that has already been registered. 

CannotProceed UserException Exception class, general purpose.

InvalidName UserException Exception class that is raised by passing a 0-length name or a 
name that otherwise violates a CosNaming implementation; for 
example, a name containing spaces, etc.

NotEmpty UserException Exception class that is raised when you attempt to destroy a 
non-empty naming context.

NotFound UserException Exception class that is raised when a name is looked up in the 
naming service that does not exist.

Technical Note number Subject

10950 “IIOP: Forte Service Objects and VisiBroker Java IIOP clients”

10951 “IIOP: Forte data types to IDL data types to VisiBroker for Java data types”

11145 “IIOP: Java call-out using VisiBroker For Java”

11152 “IIOP: VisiBroker for Java call-in & call-out and Forte anchored objects”

Technical Note number Subject

11057 “IIOP: Forte Service Objects and OrbixWeb Java IIOP clients”

11058 “IIOP: Forte data types to IDL data types to OrbixWeb data types”

11146 “IIOP: Java call-out using OrbixWeb”

11153 “IIOP: OrbixWeb Java call-in & call-out and Forte anchored objects”
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TOOL Server Design
A TOOL server is an application with at least one object that has been made available to 
one or more CORBA clients. The section “Getting an Object Reference” on page 16 explains 
how an object makes itself available to a client. Typically the object is a service object, but 
it does not have to be. The implementation of TOOL servers is examined in detail in the 
chapter “CORBA Servers” on page 29. The following subsections focus on how messages 
are conveyed to the TOOL server through a listener and on your design options when 
configuring a listener. 

Figure 2 Forte IIOP Server

As you can see in Figure 2, there is another service that is involved in communicating with 
a TOOL/CORBA server, the listener. The listener is connected to a particular TCP/IP 
address and port and uses the CORBA infrastructure to accept and respond to client 
messages. It communicates with objects inside the Forte 4GL environment by using 
standard Forte 4GL protocols. 

Accessing other distributed
objects

The listener contacts the service object first. If the client application calls a service object 
method and obtains a reference to another distributed object, subsequent calls to the 
distributed object also go through the listener, but the listener can then communicate 
directly with the distributed object. (The client can call the distributed object directly.)

This is not the case for any objects that have been advertised in the naming service or for 
which object_to_string has been called before they were passed out by the service object. A 
call to these objects would go directly to the object through a listener local to those objects, 
not through the service object’s listener. Thus using the naming service or object_to_string 
should be avoided if calls to these objects need to go through the same listener as the 
service object

Accessing multiple service
objects

Figure 2 shows only one service object. However, you could have multiple service objects in 
a Forte 4GL environment, all of which are known to the client and all of which are directly 
accessible through IIOP. You can associate each CORBA service object with its own listener, 
or associate a single listener with multiple service objects. There is a limit of one listener 
per partition, so if you choose to have one listener for each service object, each service 
object must be in its own partition. (To associate each service object with its own listener, 
you must use the IIOP configuration dialog as shown in “One Listener Per Service Object, 
Same Partition” on page 21.)

If you are using an IOR string to access a service object that has been configured using the 
IIOP configuration dialog, each object must be listed in a separate IOR file to be directly 
accessible. (The IOR string provided in the IOR file contains both the TCP/IP host and port 
for a listener and specifies which service object the listener is to contact.) 
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Stand-alone listeners If, for security reasons, you want to set up a single listener for all your CORBA service 
objects, you can use the IIOP Gateway application. This application is provided for the 
following circumstances:

■ It can provide a single point at which a Forte 4GL environment receives IIOP requests, 
thus satisfying the requirements of Java security. 

■ If your TOOL server requires a listener on a separate partition, Forte starts an IIOP 
gateway on that partition, and the gateway starts the listener.

For more information about the IIOP gateway, see “Using the Forte IIOP Gateway” on 
page 24.

Listener and Service Object Configurations
When a client uses an object reference to invoke a method on a TOOL server, the listener 
routes the request to the appropriate service object. You can use a single listener to access 
multiple service objects, or you can use multiple listeners. A listener can be on the same 
partition as the service object it accesses, or it can be on a remote partition. In order to 
control the configuration of service objects and listeners, you must use the IIOP 
configuration dialog for the service object. This is especially important if you need to set up 
a server for load balancing or failover. 

The configuration dialog is shown in Figure 3. The sections that follow describe a number 
of listener-service object configurations. Each section provides brief information about the 
configuration parameters for the service objects. You would use the configuration dialog to 
set these parameters.

Figure 3 IIOP Configuration Dialog

For complete information about configuration parameters and how to set them in the 
Partition Workshop, see “Specifying that a Service Object Is a CORBA Server” on page 34. 
For information about setting these configuration parameters using the Fscript 
SetServiceEOSInfo command, see “Configuration Parameters for a TOOL CORBA Object” 
on page 70.
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One Listener Per Service Object, Same Partition
If you define multiple service objects as CORBA servers, you can have a listener for each 
service object and put both the listener and its service object in the same partition, as 
shown in Figure 4:

Figure 4 An IIOP Client Invoking Methods of Forte Service Objects

This is the default configuration. The ListenLocation configuration setting of each listener 
is here (same partition as the service object) and the Mode is forward (send the request on 
to the object) for each service object. See “Specifying that a Service Object Is a CORBA 
Server” on page 34 for more information on these settings.

The configuration shown in Figure 4 will also result when using the naming service or 
object_to_string.

Forward Mode
If you define multiple service objects as CORBA servers, you can use a single listener for all 
of them. As shown in Figure 5, you can put the listener in its own partition and each service 
object in a separate partition. You must then specify that the listener forward each request 
to the appropriate service object in the appropriate partition.

Figure 5 A Single Listener for all Service Objects in the Forte Environment
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The ListenLocation configuration setting for the two service objects, whose partitions do 
not contain a listener, is remote (listener is in a different partition), with the host and port 
values set to the listener’s partition. For both service objects, the Mode is forward (send the 
request on to the object). 

Redirect Mode
In redirect mode, illustrated in Figure 6, the listener notifies the caller to send the IIOP 
request to the partition containing the appropriate CORBA service object. If the service 
object is in another partition, Forte 4GL automatically starts a listener for that partition if 
necessary. 

Figure 6 Having IIOP Clients Redirect Requests Directly to the Correct Partition

In Figure 6, the IIOP gateway application is the listener. The Mode is redirect. For the 
service objects in other partitions, the ListenLocation for the listener is remote, and the 
port and host values are those of the IIOP gateway.
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Load Balancing
To perform load balancing, the listener must be in the same partition as the router. The 
router then manages the balancing of requests to the replicated partitions. 

Figure 7 Load Balancing with a Forte IIOP Server

Failover
Failover only works when the listener is in a different (remote) partition from the replicated 
service objects, as shown in Figure 8. 

Figure 8 Failover with a Forte IIOP Server

The remote listener maintains a list of potential failover candidates (server partitions). A 
single IOR file is generated for this remote listener partition.

Caution To get failover support, the listener must not be in the same partition as the server. If the 
listener is in the same partition for each of the failover partitions, only one of the partitions 
will be usable by CORBA clients because the same IOR file is used for all the partitions. 
With only one partition usable, failover will not occur.
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Using the Forte IIOP Gateway
If you want to have a listener run separately from your application, you can use the IIOP 
gateway, a 4GL application named iiopgw that starts a listener. You can also use this 
application when you want to have all IIOP clients send requests to a single listener at a 
single port.

Using a single port is a way to avoid restrictions imposed by Java security, which permits an 
external browser running a Java applet to access only the Web server machine. You can 
have CORBA clients access a single listener that resides on the Web server machine (if 
necessary, a listener started by an IIOP gateway). Forte 4GL then routes the requests to 
other TOOL partitions, as shown in the following figure: 

Figure 9 Using the IIOP Gateway

Installing the IIOP Gateway Application
You can install the IIOP gateway application by using the Environment Console or Escript.

� To install the IIOP gateway application with the Environment Console:

1 Load the application distribution for the iiopgw application by choosing File > Load 
Distribution in the Environment Console’s Active Environment window and selecting 
the iiopgw_cl0 application distribution.

2 Put the iiopgw server partition on a node running on the machine where you want to 
have a listener running. 

a In the Environment Console’s Node Outline view, lock the environment. 

b Drag or cut-and-paste the server partition to the node where you want the server 
partition installed. 

c Unlock the environment.

3 Install the application.

In the Environment Console’s Application Outline view, select the iiopgw_CL0 
Application agent and choose the Component > Install command.

� To install the IIOP gateway application with Escript:

1 Load the application distribution for the iiopgw application by using the following 
command:
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2 Put the iiopgw server partition on a node running on the machine where you want to 
have a listener running. Choose the Application agent for the iiopgw_cl0 application, 
then use the following commands: 

3 Install the application by choosing the Application agent for iiopgw_CL0 Application 
agent, then using the Install command.

Starting the IIOP Gateway
Typically, the IIOP gateway starts automatically with the startup of a partition that contains 
a service object marked as needing a remote listener. However, you can also start the IIOP 
gateway manually.

By default, Forte automatically tries to start the IIOP gateway application if a listener is not 
running where a service object expects one. If the IIOP gateway application is not installed 
on the node where Forte tries to start it, Forte raises a DistributedAccessException. You can 
set the DisableAutoStartGW property to prevent Forte from trying to automatically start the 
IIOP gateway application, as described in “Disableautostartgw Parameter” on page 74. 

Setting Up for Automatic Startup of the IIOP Gateway
Before the IIOP gateway can be started automatically, you must define the IIOP 
configuration parameter by using either the Environment Console or Escript.

� To define the IIOP port configuration parameter in the Environment Console:

1 Open the properties dialog for the installed iiopgw_CL0_Part1 partition on the Installed 
Partition agent.

2 Enter the -iiop flag and the configuration parameters in the Server Arguments field.

3 Click the Close button.

4 Choose Component > Startup to start the partition.

� To define the IIOP port configuration parameter in Escript:

Specify the -iiop flag and the parameter by using the Installed Partition agent’s Startup 
command, as follows: 

Starting an IIOP Gateway Manually
When you start an IIOP gateway manually, you can define the port parameter for the IIOP 
gateway application. To specify this configuration parameter, you need to use the -iiop flag 
defined for the IIOP gateway (iiopgw) application. You cannot define the IORFile 
parameter for an IIOP gateway. If the configuration parameter contains any spaces, you 
must enclose the entire value in quotation marks.

You can specify the port number where the listener should listen for messages by using the 
port parameter, as described in “Port Parameter” on page 73. For example, you can use the 
following command: 

escript> LockEnv

escript> FindSub iiopgw_cl0_Part1

escript> Assign <node_name>

escript> UnlockEnv

escript> Startup “-iiop port=2500”

Specify all on one line ftexec -ftsvr 0 -fi bt:$FORTE_ROOT\userapp\iiopgw\cl0\iiopgw1 

-iiop “port=2500”
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Configuring a Service Object to Use the IIOP Gateway
The IIOP gateway application starts a listener on the same node as the gateway (the node 
that the gateway is installed and running on). Service objects enabled to be CORBA servers 
can specify that they use this listener by specifying ListenLocation = remote, Host = 
host_name, and Port = port_number, where the host_name and port_number correspond to 
those of the listener started by the IIOP gateway.

For example, if the IIOP gateway is installed on a node on the machine called James and is 
configured to listen at port 4500, an IIOP server in the Forte 4GL environment can specify 
its ListenLocation, Host, Port, and IORFile parameters as follows:

ListenLocation = remote, Host = James, Port = 4500, IORFile = (name = BankSvc)

In this case, the service object defines its listener as the one started by the IIOP gateway 
application. This listener then routes messages for the service object to the partition 
containing the service object.

For more information on configuring service objects, see “Specifying that a Service Object 
Is a CORBA Server” on page 34.
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Building a CORBA-Enabled Application
This section describes the steps required to write and build a CORBA application.

Create the IDL Interface Definition
1 Get the IDL text file that describes the interface of the CORBA object whose methods 

you want to invoke. 

2 Use the appropriate tool or compiler to generate the files required by CORBA: these 
normally include the implementation version of the IDL interface, the client stub, the 
server skeleton, and one or more helper classes. For example, use the idlj (jdk 1.3) 
compiler to generate files for a CORBA object accessed from Java; use the corbagen tool 
to generate files for a CORBA object accessed from TOOL. The table below lists the IDL 
compilers supported in the current version of Forte 4GL

If you use the IIOP configuration dialog to configure a TOOL server, the IDL file is 
automatically generated for you.

Implement the Client
A client that wants to use a distributed CORBA object must do the following:

1 Include the required libraries and the files generated by the IDL compiler.

2 Get a reference to the object implementation from an IOR file or from the naming 
service.

3 Invoke the method.

For code examples that illustrate these steps, see “Working with CORBA Clients” on 
page 43.

Implement the Server
A server containing a CORBA object that can be accessed by a client must:

1 Include the required libraries and the files generated by the IDL compiler.

2 Provide a reference to the object implementation using an IOR file or the naming 
service.

3 Implement the CORBA object that contains the methods whose interface are given in 
the IDL file.

If you use the IIOP configuration dialog to configure a TOOL server, the IDL file is 
automatically generated for you.

The implementation of these steps differs depending on the server’s source language and 
on the mechanism used to pass the object reference to the client. For code examples that 
illustrate these steps, see “CORBA Servers” on page 29.

Compiler/Tool Description

Sun idlj.exe Maps IDL to Java. Shipped with JDK 1.3.

corbagen.exe Maps IDL to TOOL. Shipped with Forte 4GL.

Iona OrbixWeb 3.2 idlj.exe Maps IDL to Java. 

Inprise VisiBroker 4.0 idl2java.exe Maps IDL to Java. 
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Build and Run the Application
� To build an application that supports the use of CORBA objects, follow these steps:

1 Use the appropriate tool or compiler on the IDL text file to generate the files required 
for CORBA support. 

2 Compile and link the source files, including the files generated in Step 1 for both the 
client and the server.

3 Make a distribution. This generates the IDL file if the object implementation was 
configured using the IIOP configuration dialog. (Not applicable for non-TOOL 
applications.)

4 If you are using a naming service, make sure the naming service is running.

5 Start the server.

6 Start the client in a different shell or on a different machine from the server.

The first two steps may be completed in different ways, depending on the development 
environment and the tools you use to build your application.
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CORBA Servers
This chapter begins with an overview of CORBA servers and then examines a Java and 
TOOL server implementation as examples. You should read this chapter if you need to 
create, build, test, and deploy a CORBA server.

You need to read the chapter “Interoperating With CORBA Objects” on page 13 before you 
read this chapter.
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Servers
A CORBA server is an application with at least one object that is accessible by a CORBA 
client. The client accesses the external object through an object reference that it obtains 
either through a naming service or through an IOR file. The client developer must also be 
able to access the IDL file that defines the interface to the external object, in order to 
generate the stub files required for the CORBA communication infrastructure.

In general a CORBA server, independently of its source language, must do the following:

■ Create an IDL file and document its location for the client.

■ Make an object reference available to the client. 

■ Implement the methods whose prototypes are given in the IDL file.

The TOOL and Java examples given in this chapter show two possible server 
implementations. 

Accessing Distributed Objects
If the CORBA object returns object references that allow the client to call methods on other 
server objects, the IDL file must contain IDL declarations for these objects as well, just as it 
does for the original object implementation. This is true both for Java and TOOL servers.

Clients can access any distributed object in the Forte 4GL environment for which the 
following conditions are true:

■ The distributed reference to the object can be returned from another object that is 
accessible through IIOP.

For example, a service object has a method that returns a reference to a distributed 
object. Your IIOP client can invoke that method to get the reference to the distributed 
object, then use that reference to directly invoke methods of the distributed object.

■ At least one method for the distributed object can be exported as IDL.

The parameters for the methods of distributed objects must conform to the same rules 
as those for service objects, as described in “Parameter and Return Values” on page 63.

■ The distributed objects are actually anchored, or they implement CorbaObject (which is 
always the case if the object’s class inherits from CorbaObjectImpl.

Distributed objects must be anchored, which means that they reside in one partition, 
and other partitions access the object using distributed references. Because a class 
definition can specify that its objects are distributed, but not require that all objects of 
that class be anchored, it is up to the TOOL programmer to set the IsAnchored property 
for each distributed object of the class to TRUE. (See the Forte 4GL Programming Guide 
for a thorough discussion of distributed objects.) 

If the IDL file is generated automatically, Forte 4GL generates IDL for any class used by 
the service object that specifies Distributed = Allowed, even if the objects are not 
anchored by default. Because IIOP clients cannot access objects of these classes unless 
the objects are anchored, you must ensure that these objects are actually anchored 
when IIOP clients attempt to access them. Otherwise, the client will produce runtime 
errors.
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TOOL Servers
TOOL server writers have a number of options to choose from, depending on the following 
factors:

■ Whether they want the implementing object to be a service object.

■ Whether they want to use the naming service or an IOR file to pass the object reference 
to the client.

■ Whether they want the IOR file to be generated automatically.

■ Whether they want the IDL file to be generated automatically.

Object or Service Object The object implementation does not have to be a service object. If it is not, you cannot use 
the IIOP configuration dialog and therefore cannot have the IDL file and the IOR file 
automatically generated. You must write them yourself. You also cannot specify the 
location of the listener, but must use the default configuration. For a description of the 
default configuration, see “One Listener Per Service Object, Same Partition” on page 21.

Naming Service or IOR file If you use the naming service to register CORBA objects, you can still use the IIOP 
Configuration dialog to specify the location of the listener. In this case, an IOR file is still 
generated, but it can be ignored since it is not needed.

No matter how you pass the object reference, you must use ORB methods either to connect 
to the naming service to register the object implementation or to convert the object 
reference to an IOR string. The sample code on page 32 shows the code you need to write 
to access an ORB.

For more information about TOOL CORBA server architecture, see “TOOL Server Design” 
on page 19.
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Working with TOOL Servers
The following sections explain the steps you must take to create a TOOL server. Note that in 
this case—where the CORBA object is a service object and the IIOP configuration dialog is 
used, generating the IDL file is part of making a distribution, as shown in Step 8 on page 33. 
As mentioned earlier, the object implementation does not have to be a service object. 
However, this is likely to be the most common case, and therefore, a service object is used 
in the following example.

� To create a project for the server and specify the suppliers for your project:

1 Create a project for the server implementation by choosing Plan > New Project from the 
Repository Workshop and specifying the name of your project, for example, TestServer.

2 To specify the suppliers to your project, open the Project Workshop and choose File > 
Supplier Plans. Specify the CosNaming library and the Corba library as suppliers.

3 You also need to add the compiled IDL file as a supplier. In the Project Workshop, 
choose File > Supplier Plans, and specify the name of the .pex file as a supplier. This file 
will not be available until after you make a distribution, as shown in Step 8 and Step 9 
on page 33.

Step 3 is not necessary if you create the IDL file during distribution. However, you do 
need to explicitly add the IDL file as a supplier if you have used an external IDL 
definition as a starting point when writing the server. For example, the IDL file might 
contain an interface that you are trying to implement in TOOL. In this case the interface 
translates into a TOOL class in the generated .pex file. You could then write the server so 
that it inherits from the TOOL class. In this case, you can ignore the IDL generated at 
distribution time. 

Note that by starting the server from an existing IDL file, you retain more control over 
the IDL file because you can keep implementation methods, which the client will never 
call, private to the server.

Implementing the TOOL Server
As opposed to creating a Java server (which includes setup code as well as the object 
implementation), when you create the TOOL server, the setup work is part of the 
initialization method for the service object.

� To create the service object:

1 Create a distributed class, for example TestClass, in your server project (TestServer).

2 Create the service object TestClassSO for TestClass.

3 Make sure that the class for your service object implements the interface 
Framework.SOInitializer.

4 Add a method Initialize() to your service object with the following signature:

Initialize(): integer
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5 Provide the following implementation for the Initialize method:

6 Add a method TestServer.HelloMethod() to your service object with the following 
signature:

7 Provide the following implementation for HelloMethod:

8 Make a distribution.

This creates an IDL file, corba1.idl in the following directory:

9 Use one of the following commands to generate the required Java stub code:

theOrb : Corba.ORB = Corba.ORB();

args : Array of TextData = new;

args.AppendRow(TextData(Value = ‘-ORBInitialPort 1050’));

theOrb.Initialize(args);

nameArray : Array of CosNaming.NameComponent = new;

nameComp : CosNaming.NameComponent = new;

nameServiceObj : Corba.CorbaObject =
theOrb.resolve_initial_references(‘NameService’);

// narrow

nameServiceObj = theOrb.narrow(nameServiceObj,
CosNaming.NamingContext);

// typecast

nameService : CosNaming.NamingContext =
CosNaming.NamingContext(nameServiceObj);

nameComp.id = ‘ToolTestServer’

nameComp.kind = ‘’;

nameArray.AppendRow(nameComp);

nameService.rebind(nameArray,self);

return 0;

HelloMethod(param : string)

task.Lgr.PutLine(‘Entering TestServer.HelloMethod’);

task.Lgr.PutLine(param);

task.Lgr.PutLine(‘Leaving TestServer.HelloMethod’);

appdist\testenv\testserv\c10\generic\testse1

idlj -fclient corba1.idl
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Using an IOR File to Pass an Object Reference
When you use the IIOP configuration dialog to configure the object implementation, an 
IOR file is automatically generated for you. If you do not use the configuration dialog, you 
can use code like the following in the object’s SOInitializer.Initialize() method to pass the 
reference to the client.

The IIOP configuration dialog is described in the next section.

Specifying that a Service Object Is a CORBA Server
To mark a service object as a CORBA server you must either specify certain information in 
the Partition Workshop’s Service Object Properties dialog or use the Fscript 
SetServiceEOSInfo command.

� To mark a service object for IIOP availability in the Partition Workshop:

1 In the Repository Workshop, select the main project for the Forte 4GL application and 
click the Partition Workshop icon.

2 In the Partition Workshop, expand the server partition to display the service object, then 
double-click the service object to open its Service Object Properties dialog.

3 Select the Export tab page and choose IIOP for the External Type, then click OK to 
display the IIOP Configuration dialog.

// theOrb and portableFileName : String are assumed to have been

// defined

iorString : String = theOrb.object_to_string(obj);

f: File = new;

f.SetPortableName(portableFileName);

f.Open;

f.Write(iorString);

f.Close;

// Catch I/O exceptions here & make sure to close file
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4 In the IIOP Configuration dialog, specify the service object’s IIOP configuration settings.

The settings are described in the following list:

■ IOR File settings 

■ Listener settings (for more information, see “TOOL Server Design” on page 19)

Field Description

Name Specifies the name and location of the IOR file. 

If you do not specify a path, the file is put in FORTE_ROOT/etc/iiopior directory.

Create at Specifies when the IOR File is created. By default, the IOR File is created at runtime.

Runtime specifies that the IOR File is created when the service object is started. This 
setting is the default and gives you the most flexibility.

Distribution specifies that the IOR File is created at the time the application 
distribution is made. 

If you choose distribution, your development environment must be the same 
environment as your deployment environment.

Field Description

Location Specifies whether the listener is in the same partition (here) or on another partition 
(remote).

Here specifies that a listener starts in the same partition as the service object.

Remote specifies that a listener in another partition or an IIOP gateway receives 
requests for this service object.

If you choose this option, you must also specify the listener’s Host and Port fields.

Options Specifies how IIOP requests get routed from an IIOP client to the Forte distributed 
object in another partition. By default, a listener receives each request from a client 
and forwards these requests to the service object.

Redirect Requests specifies that the IIOP client send requests directly to a listener on 
the partition containing the distributed object. 

The Disable Auto Start toggle is available only if you have chosen to use a remote 
listener (Remote radio button). You can check this option to specify that the IIOP 
gateway not be automatically started if it is not already running. 
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5 Click the OK button.

For more information about specifying service object properties, see A Guide to the Forte 
4GL Workshops.

� To mark a service object for IIOP availability by using the Fscript SetServiceEOSInfo 
command:

1 Start Fscript. 

2 Open the repository. Make the deployment environment the current environment, and 
make the main project for the application containing this service object the current 
plan. For example:

3 Partition the application with the Partition command.

4 Enter the SetServiceEOSInfo command by using the following syntax:

SetServiceEOSInfo service_object_name iiop 
“[outbound,] IORFile = (name=iorfile_name [, runtime | dist])
[, listenlocation = here | remote] [, forward | redirect]
[, host = host_name] [, port = port_number] [, disableautostartgw]“

service_object_name is the name of the service object that you want to make available to 
IIOP clients. If the current project contains the service object, you can specify just the 
name of the service object; otherwise, service_object_name should specify the project 
name and the service object name, separated by a period.

Host Specifies the name (or the IP address) of the host machine on which the listener is to 
run. This host name is included in the IOR file. 

You can only specify a host name if the listener location is Remote. 

If the IOR string is to be created at distribution time and you do not specify a host 
name, then the name of the host on which the application distribution is made is put 
into the IOR string. This default might not be appropriate when you deploy your 
application in a runtime environment. Generally, when you create an IOR string at 
distribution time and you have a remote node that uses IIOP, you must specify the 
host name of that remote node.

If the IOR string is to be created at runtime and you do not specify a host name, the 
name put in the IOR string is name of the host on which the partition that contains 
the service object is running.

Port Specifies the port number for a listener to which the IIOP client can send requests. The 
port number is included in the generated IOR file.

You must specify a port number when the IOR file is created at distribution time or if 
you have specified a remote listener.

You do not have to specify a port number when the listener is here and the IOR file is 
generated at runtime because the operating system can assign a port number at 
runtime, and Forte can include that port number in the IOR file.

Field Description

fscript> Open

fscript> FindEnv MyEnvironment

fscript> FindPlan MainProject
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The following example marks the BankServer service object as an IIOP server:

In this example, BankServices is the name of the project, and BankServer is the name of 
the service object. BankServ.ior is the file name for the IOR file, which is placed in the 
FORTE_ROOT/etc/iiopior/ directory at runtime.

For more information about using Fscript to specify IIOP configuration settings, see 
“Configuration Parameters for a TOOL CORBA Object” on page 70.

For more information about Fscript, see the Fscript Reference Manual.

Testing, Making the Distribution, and Installing
This section provides an overview of how you can test and deploy your TOOL application 
for use as an IIOP-IDL server.

Testing Your Application
You can test run your Forte application with IIOP clients by using the Forte Partition 
Workshop or Fscript if you specify that the IOR files are generated at runtime. Even if you 
want to have the IOR file for the application generated at distribution time, you need to 
specify that the IOR files be generated at runtime to test run the application within the 
Partition Workshop or Fscript. You can then change the configuration parameter back to 
distributed after you have finished your test runs.

For details about performing a test run in the Partition workshop, see A Guide to the Forte 
4GL Workshops. For details about performing a test run in Fscript, see Fscript Reference 
Manual.

Making a Distribution
Make a distribution using the Partition Workshop or the Fscript MakeAppDistrib 
command. Making a distribution generates IDL and, optionally, IOR files, which provide 
the information needed to access Forte service objects as IIOP servers, as well as the usual 
files for the Forte partition.

No need to compile for IIOP Forte does not produce any server stubs that require compiling, so you do not need to use 
the Fcompile utility or the auto-compile facility to enable IIOP clients to access the Forte 
service object. If the partition containing the service object is marked as compiled, then 
you can compile this partition as usual, using the Fcompile utility or the auto-compile 
facility, as described in A Guide to the Forte 4GL Workshops.

corba#.idl file When you make a distribution that includes one or more partitions that contain service 
objects that are marked as IIOP servers, Forte generates an IDL file for each partition called 
corba#.idl. Each IDL file contains the IDL for all classes in the partition.

The IDL file for a partition is placed in the following directory path when you make a 
distribution:

FORTE_ROOT/appdist/environment_id/application_id/cl#/generic/partition_id/

If you install the application, the IDL file is placed in the same directory as the other files 
for the partition:

FORTE_ROOT/userapp/application_id/cl#/

If more than one service object in a partition is marked as an IIOP server, the IDL for all the 
distributed objects is placed in the same corba#.idl file for the partition. 

               Type on one line fscript> SetServiceEOSInfo BankServices.BankServer iiop 
“iorfile=(name=BankServ.ior)” 
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If you also select auto-install, making the distribution also installs the IDL files on the 
appropriate nodes in the development environment, according to the configuration you 
specified when you partitioned your TOOL application. Auto-install is usually a testing 
convenience. Unless your deployment environment and development environment are 
identical, do not auto-install.

Caution If you chose to create the IOR file at distribution, your deployment and development 
environments must be the same environment. For information on choosing when to create 
the IOR file, see the description of the Create At field on page 35.

If you specified runtime as an IOR File configuration setting, Forte generates the IOR string 
when you start the partition containing the service object. If you are deploying the 
application, runtime is usually the best choice.

For information about making a distribution using the Partition Workshop see A Guide to 
the Forte 4GL Workshops. For information about the Fscript MakeAppDistrib command, 
see the Fscript Reference Manual.

Installing the Forte Application
If you used auto-install, you are done with this procedure. Otherwise, use the Environment 
Console or Escript to install the application containing the Forte service object using 
standard Forte installation procedures. For more information about installing applications 
in Forte, see the Forte 4GL System Management Guide.

Documenting the IIOP server
When Forte generates the IDL for a partition containing one or more service objects, Forte 
generates the IDL only for a service object’s classes. The user will not be able to determine 
from the IDL which classes are the classes for the service objects. Therefore, along with the 
methods, attributes, and exceptions for each class, you also need to document for each 
service object:

■ the service object’s class

■ the name and location of its IOR file

■ when the IOR files are generated

■ the partition containing the service object
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Working with Java Servers
The following sections explain how you write and build a Java server. 

If you are writing a Java CORBA server, you must start with the interface given in the IDL 
file. In TOOL this is optional. The Sun JDK and other Java ORB vendors provide a tool to 
translate IDL to Java, but not to translate Java to IDL. TOOL on the other hand can create 
IDL from an existing server implementation.

Remember that you must first compile the IDL interface file to provide the mapping and 
support required by the Java server. You use the same IDL source text file for the server as 
you did for the client.

� To compile the file for the Java server:

1 Start a command-line shell and run the compiler on the idl source file. (For information 
on flag settings for your compiler, please consult the documentation provided). The 
following sample command compiles the Hello.idl source file.

This generates up to six files in a subdirectory that has the same name as the module, in 
this case, helloModule. The table below describes the contents of these files:

module HelloModule

{

interface HelloInterface

{

void HelloMethod(in string param);

};

};

idlj -fserver hello.idl \\jdk 1.3

File name Contents

_HelloInterfaceImplBase.java An abstract class that functions as the server skeleton, providing basic 
CORBA functionality for the server. It is used to implement the 
HelloServer.java interface. This is the abstract class from which the server 
implementation inherits.

_HelloInterfaceStub.java The client stub that provides CORBA functionality for the client. It 
implements the HelloServer.java interface.

HelloInterface.java The Java version of the .idl file. It contains the single method, HelloMethod. 
The Hello.java interface extends org.omg.CORBA.Object, providing standard 
CORBA object functionality as well.

HelloInterfaceHelper.java A class that provides additional functionality, primarily the narrow() method 
required to convert CORBA object references to their proper type.

HelloInterfaceHolder.java A class that holds a public instance member of type Hello. It provides 
operations for out and inout arguments, which CORBA has but which do 
not map readily to Java’s semantics.

HelloInterfaceOperations.java Base class to HelloInterface (JDK 1.3 only).
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Implementing the Server
The server implementation needs to contain two classes: a main class that does the setup 
work and a class that provides the object implementation. The following code shows how 
you do this in Java.

\\ import required libraries

import java.io.*;

import java.util.*

import java.Properties;

import org.omg.CORBA.*

import org.omg.CosNaming \\ if using the name service

\\ the object implementation

class myHello extends helloModule._HelloInterfaceImplBase

{

public void HelloMethod(String param1)

{

System.out.println(“In server’s HelloMethod”);

System.out.println(param1);

}

};

\\ The server implementation

public class HelloSvr

{

public static void main(String[] args)

\\ set default value for host name and port number if these

\\ are not passed from the command line that starts the server

{

try

{

String orbArgs[];

if (args.length > 0)

{

orbArgs = args;

}

else

{

String defaultArgs[] = {“-ORBInitialPort”, “900”};

orbArgs = defaultArgs;

}

// initialize ORB

org.omgCORBA.ORB orb = org.omg.CORBA.ORB.init(orbArgs, null);

// get reference to name service and narrow it to desired type

org.omg.CORBA.Object objNameService = 

orb.resolve_initial_references(“NameService”);

NamingContext ctx = NamingContextHelper.narrow(objNameService);

// initialize object instance and register it with the ORB
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Using an IOR file to Pass an Object Reference 
The previous code sample uses the name service to make object references available to the 
client. It registers the object with the name service; the client code can then query that 
service to obtain the object reference. 

However, you also have the alternative of passing the object reference to the client by way 
of an IOR (interoperable object reference) file. In order to do this, the server’s main 
function must include code like the following:

myHello svrMine = new myHello ();

orb.connect(svrMine);

// advertise (bind) the object reference in the naming context

NameComponent nc1 = new NameComponent(“MyServer”, “text”);

NameComponent[] name1 = {nc1};

ctx.rebind(name1, svrMine);

// listen for method invocation

try

{

java.lang.Object sync = new java.lang.Object();

synchronized (sync)

{

sync.wait();

}

}

// error handling

catch (InterruptedException ie)

{ System.out.println(“Hello Servers shutting down.”);}

catch(org.omg.CORBA.UserException e)

{ System.err.println(e);}

catch(org.omg.CORBA.SystemException e)

{System.err.println(e);}

}

}

//in server main

myHello svrIOR = new myHello(“FROM_IOR”);

//register object with ORB

orb.connect(svrIOR);

//use ORB method to convert object reference to string

String ior = orb.object_to_string(svrIOR); 

//use helper function to write string to file

PutIOR(ior, “d:/mydir/hello.ior”);
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The PutIOR helper function, which you use to write the string to a file, is shown in the 
following code sample. You need to include this method in your Java server code.

Building the Server
� Follow these steps to build the Java server:

1 If you have not already done so, run the idlj compiler on the IDL file to create the stubs, 
skeletons, and other supporting files.

2 Compile the .java files, including the files generated by the idlj compiler. The code 
sample below assumes that all the files (source and generated files) are in the same 
directory.

3 If you are using a name service, start it now:

4 Start the Java server.

public static void PutIOR(String ior, String fileName)

{

DataOutputStream output = null;

try

{

FileOutputStream x = new FileOutputStream(fileName);

output = new DataOutputStream(x);

}

catch(IOException ex)

{

System.err.println(ex);

return;

}

try

{

output.writeBytes(ior);

output.close();

}

catch(IOException ex)

{

System.err.printlen(ex);

}

}

idlj hello.idl

javac *.java 

tnameserv -ORBInitialPort 1050&

java HelloSvr -ORBInitialPort 1050
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Working with CORBA Clients
This chapter begins with an overview of CORBA clients and then examines a Java and 
TOOL client implementation as examples. You should read this chapter if you need to 
create, build, test, and deploy a CORBA client.

You need to read the chapter “Interoperating With CORBA Objects” on page 13 before you 
read this chapter.
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Client Overview
This section provides general guidance for writing and running clients that interact with 
external object implementations using the ORB infrastructure.

For additional examples of IIOP clients for Forte IIOP servers with the ORB products 
VisiBroker for Java or OrbixWeb, see the following Technical Notes:

■ 10950 and 10951 (Visigenic VisiBroker for Java)

■ 11057 and 11058 (Iona OrbixWeb)

Files Needed by IIOP Clients
In order to call an external object implementation transparently, the client needs access to 
the following files:

■ IDL files: these text files specify the interface to the object implementation. The ORB 
product you are using provides an IDL compiler that converts the interface defined in 
IDL to the client’s source language. 

The IDL compiler generates several output files. The stub file is specifically needed by 
the client both to enable language transparency and because the stub contains 
generated code that handles the marshalling of method invocations.

The server creator is responsible for generating the IDL files and making them available 
to the client.

■ IOR files: these text files contain strings that specify references to external object 
implementations. The client uses the IOR string to bind to the object implementation at 
runtime. If the client gets an object reference using a naming service, no IOR file is 
needed.

If the CORBA object is configured using the IIOP Configuration dialog, the IOR file is 
automatically generated either when the distribution is made or at runtime. If the IIOP 
Configuration dialog is not used, the server creator must create the IOR file manually 
using the ORB method object_to_string. Either way, the server creator is also 
responsible for documenting the file’s use, explaining how to locate the file and, if 
applicable, when it is generated.

The client must access the IOR file, read the IOR strings from the IOR file, and use the 
ORB’s string_to_object method to turn these strings into object references. The client 
can then use the object references to call server methods.

Locating TOOL IDL files
If the TOOL object implementation has been configured using the IIOP Configuration 
dialog, Forte 4GL generates an IDL file for each partition that contains a service object 
marked as an IIOP server. Each IDL file is named corba#.idl, where # is the number of the 
partition. The IDL file for a partition is placed in the following directory path when you 
make a distribution:

FORTE_ROOT/appdist/environment_id/application_id/cl#/generic/partition_id/

If you install the application, the IDL files are placed in the same directory as the other files 
for the partition:

FORTE_ROOT/userapp/application_id/cl#/
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If more than one service object in a partition is marked as an IIOP server, the IDL for all the 
distributed objects are placed in the same corba#.idl file for the partition. 

Forte 4GL also provides IDL files for the Forte libraries in the FORTE_ROOT/install/inc/idl/ 
directory, as shown in the table below: 

Generating Client Stubs from IDL
Having obtained the IDL file, the client must compile the file to create the required client 
stubs. The ORB product for the client provides an IDL compiler that converts the IDL files 
to another common language, such as Java.

� To generate the client stubs from the IDL file provided by the IIOP server:

1 Copy the IDL files to your working directory. 

If the generated IDL files include the IDL files for Forte libraries, such as framewor.idl or 
displayp.idl, then you must also copy these IDL files to your working directory.

2 Run the IDL compiler to generate the client stubs. 

You can then write IIOP client applications that use the generated classes to interact with 
the Forte IIOP server. 

See the documentation for your ORB product to determine the following information:

■ how the IDL maps to the client stubs generated by the ORB product’s IDL compiler

This information includes descriptions of how data types, classes, methods, exceptions, 
and so forth are represented in the client stub files. The appendix “IDL and TOOL” on 
page 59 describes the mapping that is done between IDL types and TOOL types, and 
between TOOL types and IDL types.

■ how to write IIOP client applications that use the client stubs

■ how to run IIOP client applications that use the client stubs

Writing an IIOP Client Application
An IIOP client that accesses a server can be written using the same approach that you 
would use for any other client. That is, it is a normal client application with some added 
code whose purpose is to obtain references to object implementations. Having obtained 
these references, the client can then use these to call methods implemented by the external 
object. There are two ways to get object references: using the naming service or using an 
IOR file.

If you are using an ORB product to write your IIOP clients, its documentation describes 
how to write, compile, link, and distribute IIOP client applications.

IDL File Name Forte Library

displayp.idl Display library

framewor.idl Framework library

genericd.idl GenericDBMS library

systemmo.idl SystemMonitor library
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Using the Naming Service
If the server registers the object implementation with the Naming Service, the client must 
include code that does the following:

■ initializes the client-side ORB

■ gets a reference to the naming service 

■ obtains an object reference for the object whose methods the client wants to invoke, 
and invokes those methods 

For code samples showing how the preceding steps are implemented, see “Implementing 
the TOOL Client” on page 54 and “Implementing the Java Client” on page 50.

Reading the IOR File
If the server uses an IOR string to pass the reference to the object implementation to the 
client, the client must open the IOR file, read the IOR string, and use the ORB method 
string_to_object to convert the string to an object reference. 

See “Implementing the TOOL Client” on page 54 and “Implementing the Java Client” on 
page 50 for information about how you do this.

Check the documentation for your ORB development product for more information about 
how to obtain an object reference from an IOR string. 

Accessing Distributed Objects
Clients can access any distributed object in the Forte 4GL environment for which certain 
conditions have been met. These are described in “Accessing Distributed Objects” on 
page 30. For example, suppose the service object has a method that returns a reference to a 
distributed object. Your IIOP client can invoke that method to get the reference to the 
distributed object, then use that reference to directly invoke the distributed object’s 
methods.

The following example shows a Java client accessing attributes of a TOOL distributed 
object: 

If the server is configured with the IIOP Configuration dialog, Forte 4GL automatically 
generates an IDL file for any class used by the service object for which the extended 
property Distributed is set to Allowed, even if objects of the class are not anchored by 
default. All methods that conform to the restrictions described in “Parameter and Return 
Values” on page 63 are included in the generated IDL. Therefore, when you get the 
reference to the distributed object, you can use its methods.

-- ForteSO is a reference to a Forte service object.

-- Flight.FlightDetails is the class for a Forte distributed object.

-- ForteSO.QueryFlight() returns a distributed reference to

-- a Flight.FlightDetails object.

-- DepartFrom, DepartTime, ArriveAt, and ArriveTime are attributes

-- of the FlightDetails object.

Get distributed object ref. Flight.FlightDetails f = FlightSO.QueryFlight(flightNumber);

Call object’s methods String origin = f.DepartFrom();

String departTime = f.DepartTime();

String destination = f.ArriveAt();

String arriveTime = f.ArriveTime();
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Objects must be distributed 
(anchored) at runtime

Clients cannot access TOOL objects unless they are distributed objects, which means that 
they must be anchored. If your client gets errors when accessing a TOOL object, the object 
might not actually be anchored at runtime, even though the object’s class definition allows 
the objects to be distributed. See “Accessing Distributed Objects” on page 30 for more 
information about this issue.

No need to explicitly 
disconnect from distributed 
objects

Forte 4GL maintains information about references to TOOL distributed objects, including 
references by IIOP clients. The IIOP client does not need to explicitly disconnect from a 
TOOL distributed object after it is finished with it.

For a more detailed description about how to access Forte distributed objects using 
Visigenic VisiBroker, see Technical Note 11152. For information about accessing distributed 
objects using Iona OrbixWeb, see Technical Note 11153.

Interpreting Exception Information
When Forte generates an IDL declaration for a method that raises an exception, the IDL 
equivalent of the method signature by default raises either a GenericException or a 
UserException. These exceptions contain an ErrorDesc_struct that is defined in the 
framewor.idl file.

The ErrorDesc_struct contains the following members (the most important members for 
an IIOP client are in bold type): 

In general, the members in bold are most useful when you write routines that let your IIOP 
client programmatically catch and deal with the exception. The rest of the members 
contain diagnostic information that can help you debug your IIOP server and IIOP client 
applications.

Member Declaration Description

string ErrorText; Message attribute set for the raised Forte exception.

string ReasonCode; ReasonCode attribute set for the raised Forte exception.

string Severity; Severity attribute set for the raised Forte exception.

string ClassName; Name of the class type of the raised Forte exception.

i4 SetNumber; SetNumber attribute set for the raised Forte exception. Number of the message set that 
contains the message associated with this exception. 

i4 MsgNumber; MsgNumber attribute set for the raised Forte exception. Number of the message in the 
message set associated with this exception.

string DetectingMethod; Name of the method that raised the exception. The DetectingMethod attribute set for 
the raised Forte exception. 

i4 MethodLocation; Line number within the method where the exception was raised. The MethodLocation 
attribute set for the raised Forte exception.

string TOOLClass; TOOL class that raised this exception, if the partition raising this exception is 
interpreted. This value is an empty string for a compiled partition.

string TOOLMethod; TOOL method in which this exception was raised, if the partition raising this exception 
is interpreted. This value is an empty string for a compiled partition.

i4 TOOLLine; The line of the TOOL method in which this exception was raised, if the partition raising 
this exception is interpreted. This value is 0 for a compiled partition.

boolean IsRemote; TRUE if the exception was raised on a partition other than the partition acting as an 
IIOP server. FALSE if the exception was raised on the same partition as the IIOP server. 

string Program; Application running the partition that raised the exception, such as ftexec, ftlaunch, or 
the executable.

string TaskId; Hexadecimal number that identifies the task in which the exception was raised.

string PartitionId; Hexadecimal number that identifies the partition on which the exception was raised.
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Running a Client Application
Before you can run an IIOP client with a TOOL server, you need to install and set up the 
following components:

■ Forte 4GL runtime and TOOL application on a server machine running in a Forte 4GL 
environment

■ If the server requires it, you need to install and start the IIOP gateway application 
(iiopgw), if used, on a node in the Forte environment (see “Using the Forte IIOP 
Gateway” on page 24)

■ ORB product on the client machine

■ IIOP client application

� To run an IIOP client with a TOOL application:

1 If the IOR file is generated at runtime, start the Forte 4GL partition containing the 
service object. This automatically starts a listener. 

A listener is also automatically started if you start the Gateway application.

For information on listeners, see “Listener and Service Object Configurations” on 
page 20.

2 If the server uses the naming service, make sure it is running.

3 Start the client application.

As long as a listener is running, if the IIOP client sends a message to a distributed object in 
a Forte 4GL partition that is not running, Forte 4GL auto-starts the partition. 

You can start all the TOOL partitions ahead of time to improve the performance of the 
interaction between the IIOP client and the TOOL server.
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Working with Java Clients
This example describes the steps you need to take to create a Java client that calls a TOOL 
service object using CORBA.

Compiling the IDL File
The following code shows a sample IDL file, hello.idl, which you must compile for the client 
and the server. The text in this file specifies the interface to the CORBA object(s) you want 
to invoke; in this case the method is called HelloMethod, it returns a void, and it passes an 
input string parameter.

Creating a Java Client
The following sections explain how you write a Java client.

Compile the IDL Interface File
Start a command-line shell and run the IDL-to-Java compiler on the idl source file. (For 
information on flag settings for your compiler, please consult the documentation 
provided). The following sample commands compile the hello.idl source file.

This generates up to six files in a subdirectory that has the same name as the module, in 
this case, HelloModule. The table below describes the contents of these files:

module HelloModule

{

interface HelloInterface

{

void HelloMethod(in string param);

};

};

idlj -fclient hello.idl

File name Contents

_HelloInterfaceImplBase.java An abstract class that functions as the server skeleton, providing basic 
CORBA functionality for the server. It implements the HelloServer.java 
interface. This is the abstract class from which the server implementation 
inherits.

_HelloInterfaceStub.java The client stub that provides CORBA functionality for the client. It 
implements the HelloServer.java interface.

HelloInterface.java The Java version of the .idl file. It contains the single method, HelloMethod. 
The Hello.java interface extends org.omg.CORBA.Object, providing standard 
CORBA object functionality as well.

HelloInterfaceHelper.java A class that provides additional functionality, primarily the narrow() method 
required to cast CORBA object references to their proper type.

HelloInterfaceHolder.java A class that holds a public instance member of type Hello. It provides 
operations for out and inout arguments, which CORBA has but which do 
not map readily to Java’s semantics.

HelloInterfaceOperations.java Base class to HelloInterface (JDK 1.3 only).
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Implementing the Java Client
The Java client implementation shown below uses the naming service to get an object 
reference. It initializes the client-side ORB, it gets a reference to the naming service, it 
obtains an object reference for the object whose methods the client wants to invoke, and it 
invokes those methods. The subsections that follow discuss the implementation in greater 
detail and provide code samples that show how you use an IOR file get the object reference.

import java.io.*;

import java.util.*;

import java.util.Properties;

import org.omg.CORBA.*;

import org.omg.CosNaming.*;

Class HelloClient

{

public static void main(String[] args)

{

try

{

//create and initialize the ORB

String orbArgs[]={"-ORBInitialPort", "1050"};

org.omg.CORBA.ORB orb = 
org.omg.CORBA.ORB.init(orbArgs, null);

//get a reference to the naming context

org.omg.CORBA.OBJECT objNameService = 
orb.resolve_initial_references("NameService");

NamingContext ctx =
NamingContextHelper.narrow(objNameService);

//Get a reference to the object implementation

NameComponent nc1 = new NameComponent("ToolHelloServer", "");

NameComponent{} name1 = {nc1};

org.omg.CORBA.Object obj = ctx.resolve(name1);

HelloModule.HelloInterface svr = 
HelloModule.HelloInterfaceHelper.narrow(obj);

//call the remote method

svr.HelloMethod("Hi there, this is Java calling TOOL!");

}

catch(org.omg.CORBA.UserException e)

{

System.err.println(e);

}

catch(org.omg.CORBA.SystemException e)

{

System.err.println(e);

}

}

};
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Initializing the ORB
The initialize method creates an ORB instance and uses an args parameter to pass it the 
host name of a machine running a naming service and the port number on which the 
initial naming service listens. 

The args parameter is defined to be a string type array. This form of the init method is used 
for standalone applications and may be called from applications only.

You must use an alternate form to initialize an ORB that is created for an applet. For more 
information, see Sun’s CORBA API specification.

Getting an Object Reference from the Naming Service
The client code in the previous example uses the naming service to get a reference to a 
CORBA object. First it gets a reference to the naming service, then it initializes an array of 
NameComponent objects to specify the name of the object implementation. Finally, the 
client code passes the array to the resolve method of the naming service. The naming 
service returns a CorbaObject, which the client must first narrow to the desired type (to 
obtain a valid reference to the object implementation) and then cast it in order to work 
with it.

Getting an Object Reference from an IOR File
Using a naming service is the recommended method of obtaining an object reference. 
However, you might want to use the alternative method of having the server pass the object 
reference back to the client through an IOR (interoperable object reference) file or by some 
other means. 

The client must use the string_to_object method to turn the string it receives into an object 
reference. This is shown in the following code sample.

init(String[] args, Properties props)

// code that converts the IOR string to an object

String IORString = ReadIOR(fileName);

Omg.Omg.CORBA.Object obj = orb.string_to_object(IORString);

SomeClass MySvr = SomeClassHelper.narrow(obj);
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The code below shows a helper function that the client would use to read the IOR file and 
obtain the string. 

Starting the Naming Service
If your application uses the naming service to obtain CORBA object references, you need to 
start the naming service before you test or run your application.

� To start the naming service:

1 Open a command-line shell.

2 Enter the command to start the naming service using the following syntax:

tnameserv -ORBInitialPort portnumber

For example,

Building the Client
To build the client, compile the .java files, including the stubs and skeletons that were 
created when you compiled the IDL source file. For example:

// helper method to read a string from an IOR file

public static String ReadIOR(String fileName)

{

String retValue = null;

java.io.DataInputStream input = null;

try

{

FileInputStream inFile = new FileInputStream(fileName);

input = new java.io.DataInputeStream(inFile);

}

catch(IOException ex)

{

System.err.println(ex);

return null;

}

try

{

retVal = input.readLine();

input.close();

}

catch(IOException ex)

{

System.err.println(ex);

}

return ret Val;

}

tnameserv -ORBInitialPort 1050

javac *.java HelloApp/*.java
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Working With TOOL Clients
This example describes the steps you must complete to create a TOOL client that calls a 
Java server using CORBA.

Compiling the IDL File
The following code shows a sample IDL file, hello.idl, which you must compile for the client 
and the server. The text in this file specifies the interface to the CORBA object(s) you want 
to invoke; in this case the method is called HelloMethod, it returns a void, and it passes an 
input string parameter. It is the responsibility of the server to make the IDL file available to 
the client.

Creating a TOOL Client
The following subsections explain how you write a TOOL client.

� Compile the IDL interface file and import it into your work repository:

1 Start a command-line shell and invoke the corbagen utility using the following syntax:

corbagen -i inputfile -o outputfile

Taking the file shown in “Compiling the IDL File” as an example, you would use the 
following command:

The corbagen utility uses the flags listed in the following table. Normally, you would 
only use the -i and -o flags.

module HelloModule

{

interface HelloInterface

{

void HelloMethod(in string param);

};

};

corbagen -i hello.idl -o hello.pex

Flag Description

-I dir Specifies the directory to search for the preprocessor. If your implementation 
code includes preprocessor statements, you must use this flag.

-i filename Specifies the name of the IDL input file.

-o [filename]

[-o filename]

Specifies the name of the .pex output file that will contain the IDL - TOOL 
mapping for the interface. If you do not specify a file name, the name 
inputfile.pex will be assigned by default.

-u Prints usage message and exits.
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For example, if the IIOP server provides the IDL file hello.idl, shown above, Corbagen 
parses the file and produces the following TOOL code:

2 Import the resulting .pex file into your work repository by choosing Plan > Import from 
the Repository Workshop and specifying the file name.

Alternately, you can use Fscript to import the generated .pex file. Use the ImportPlan 
command, as follows:

For more information, see the Fscript Reference Manual.

� To create a project for the client and specify the suppliers for your project:

1 Create a project for the client implementation by choosing Plan > New Project from the 
Repository Workshop and specifying the name of your project.

2 To specify the suppliers to your project, open the Project Workshop and choose File > 
Supplier Plans. Specify the CosNaming library and then the Corba library as suppliers.

3 You also need to add the compiled IDL file as a supplier. In the Project Workshop, 
choose File > Supplier Plans, and specify the name of the .pex file as a supplier.

Implementing the TOOL Client
The TOOL client implementation shown next uses the naming service to get an object 
reference. It initializes the client-side ORB, it gets a reference to the naming service, it 
obtains an object reference for the object whose methods it wants to invoke, and it invokes 
those methods.

Generated .pex file begin TOOL HelloModule;

includes Corba;

 forward HelloInterface;

 class HelloInterface inherits from Corba.CorbaObjectImpl

has public method HelloMethod(

 input param :string

 );

has property

 distributed=(allow=on, override=on, default=on);

 end class;

method HelloInterface.HelloMethod(

input param :string

)

 begin

 end method;

end ;

fscript> ImportPlan myFile.pex
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The sections that follow discuss the implementation in greater detail and provide code 
samples that show how you use an IOR file to get the object reference.

//initialize client-side ORB

theOrb : Corba.ORB = Corba.ORB();

args : Array of TextData = new;

args.AppendRow (TextData(Value = ’-ORBInitialHost ServerMachine’));

args.AppendRow (TextData(Value = ’-ORBInitialPort ’));

args.AppendRow (TextData(Value = ’1050’))

args.AppendRow (TextData(Value = ’myPassword’))

theOrb.Initialize(args);

//get a reference to a naming service from the ORB

begin

nameServiceObj : Corba.CorbaObject = 

theOrb.resolve_initial_references(‘NameService’);

nameServiceObj = theOrb.narrow(nameServiceObj, NamingContext);

// typecast the reference returned above 

nameService : CosNaming.NamingContext = 

CosNaming.NamingContext(nameServiceObj);

// get reference to object implementation

nameComp : NameComponent = new;

nameComp.id = 'MyServer';

nameComp.kind = 'text';

nameArray : Array of CosNaming.NameComponent = new;

nameArray.AppendRow(nameComp);

mySvrObj : Corba.CorbaObject = nameService.resolve(nameArray);

mySvrObj = theOrb.narrow(mySvrObj, HelloModule.HelloInterface);

// typecast to the actual interface type

mySvr : helloModule.HelloInterface = 
HelloModule.HelloInterface(mySvrObj):

// invoke the method using the object reference

mySvr.helloMethod('Calling MyServer - do you read me?');

//exception handling

exception when e = NotFound do

//handle exception

exception when e = CannotProceed do

//handle exception

exception when e = InvalidName do

//handle exception

end;
Chapter 3Working with CORBA Clients



Working With TOOL Clients56
Initializing the ORB
The initialize method creates an ORB instance and uses an args parameter to pass it the 
host name of a machine running a naming service and the port number on which the 
initial naming service listens.

The args parameter is defined to be an array of TextData values. As shown in the client 
implementation sample code, you can specify options and values as one array element or 
use more than one element to express these. For example, note the difference between the 
number of array elements used to specify the host name and that used to specify the port 
number.

You can also append additional array elements to specify command-line arguments or 
other data. The ORB will skip these elements if it does not understand them.

Getting an Object reference from the Naming Service
The client code in our previous example uses the naming service to get a reference to a 
CORBA object. First it gets a reference to the naming service, then it initializes an array of 
NameComponent objects to specify the name of the object implementation and its kind, 
and finally, the client code passes the array to the resolve method of the naming service. 
The naming service returns a CorbaObject, which the client must narrow and typecast to 
the desired type to obtain a valid reference to the object implementation.

Note that using ORB.resolve_initial_references() does not currently work with the Visigenic 
naming service.

Getting an Object Reference from an IOR File
Using a naming service is the recommended method of obtaining an object reference. 
However, you might want to use the alternative method of having the server pass the object 
reference back to the client through an IOR (interoperable object reference) file. The code 
below shows how the client would read the file and convert the string passed in the file into 
an object reference: 

// use an IOR file to get object reference

f: File = new;

iorString : TextData = new;

f.SetPortableName(portableFileName);

f.Open;

f.ReadLine(iorString, FALSE);

f.Close

//use ORB method to convert the string to an object

theOrb : ORB = new;

obj: CorbaObject = theOrb.string_to_object(iorString.Value);

//narrow the object to the right type

obj = theOrb.narrow(obj, HelloModule.HelloInterface);

//Typecast the object to the right type

svr: HelloModule.HelloInterface = HelloModule.HelloInterface(obj);

//Call method

svr.HelloMethod(’Hi there, this is TOOL!’);
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See “Using an IOR file to Pass an Object Reference” on page 41 for the server-side code 
required to pass an object reference as a string.

Starting the Naming Service
If your application uses the naming service to obtain CORBA object references, you need to 
start the naming service before you test or run your application.

� To start the naming service of the Sun SDK (1.3 and 1.2.2):

1 Open a command-line shell.

2 Enter the command to start the naming service using the following syntax:

tnameserv -ORBInitialPort portnumber

For example:

Testing, Making a Distribution, and 
Installing the TOOL Client

The steps for testing, making an application distribution, and installing the Forte IIOP 
client application are the same as for any other Forte application, except as described in 
this section.

Testing Your Application
Before you can test your application, you must start the server application. 

■ If you are using an IOR file to get an object reference, you must get its location from the 
server provider.

■ If you are using the naming service, you must make sure it is running.

In the Partition Workshop, you can test run your client application using the Run > Run 
command.

In Fscript, you can test run your application using the RunDistrib command, as described 
in the Fscript Reference Manual.

You should also deploy your client application and test it by making a distribution and 
installing it, as described in the next section.

Making a Distribution and Installing Your Application
Using auto-install If you are installing your application to test it in your active environment, you can do so 

using the auto-install feature. 

In the Partition Workshop, you can use the File > Make Distribution command, then 
enable the Install in Current Environment toggle and the Make button to automatically 
install the application after you make the distribution. See A Guide to the Forte 4GL 
Workshops for more information about making a distribution.

In Fscript, you can use the MakeAppDistrib command, specifying the auto-install flag to 
automatically install the application after you make the distribution, as follows:

See the Fscript Reference Manual for more information about using Fscript and the 
MakeAppDistrib command.

tnameserv -ORBInitialPort 1050

fscript> MakeAppDistrib 0 "" 0 1
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Without auto-install If you do not want to install the application now, you can just make a distribution, then 
install the application later in the environment where it is to run. To do so, you can make a 
distribution without using the auto-install option, then use Escript or the Environment 
Console to load and install the application into your environment.

Caution If you chose to create the IOR file at distribution, your deployment and development 
environments must be the same environment. For information on choosing when to create 
the IOR file, see the description of the Create At field under “Specifying that a Service 
Object Is a CORBA Server” on page 34.

If you specified runtime as an IOR File configuration setting, Forte generates the IOR string 
when you start the partition containing the service object. If you are deploying the 
application, runtime is usually the best choice.

For information about installing applications using Escript, see the Escript and System 
Agent Reference Manual. For information about installing applications using the 
Environment Console, see the Forte 4GL System Management Guide.
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IDL and TOOL
This appendix describes the mapping that is done between IDL types and TOOL types, and 
between TOOL types and IDL types.
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IDL to TOOL Mappings
The corbagen tool, which takes an IDL text file as input and generates the required stub, 
skeleton, and other helper classes, supports the following mapping of IDL to TOOL. These 
mappings are described in Table 1.

Table 1 IDL to TOOL Mapping Enhancements

IDL Type TOOL Type Discussion

long i4

unsigned long ui4

float float

double double

short i2

unsigned short ui2

char ui1

boolean boolean

octet ui1

any pointer

Object Corba.CorbaObject

struct CorbaFlat class For more information, see “CorbaFlat Objects” on page 65 
and “Structs” on page 67.

sequence string array of TextData

sequence [unsigned] long array of IntegerData

sequence [unsigned] short array of ShortData The ShortData class is a new TOOL class. It is a subclass of 
IntegerData, and differs from this class only in that it is 
serialized as a 2-byte integer. The Value field in ShortData is 
still 4 bytes. This means that the value field can store 4 bytes, 
but it can only read/write 2 bytes. It is up to the user to make 
sure that the value read or written does not exceed the 2 byte 
range.

sequence char BinaryData Each element of the sequence char/octet/boolean type is 
mapped to BinaryData byte. This mapping is more efficient 
and incurs less overhead than mapping these sequences into 
TOOL arrays. In addition, the BinaryData class provides a 
wealth of methods for data manipulation.

sequence octet BinaryData

sequence boolean array of BooleanData

sequence double array of DoubleData

sequence float array of FloatData The FloatData class is a new TOOL class. It is a subclass of 
DoubleData, and differs from this class only in that it is 
serialized as a 4-byte float. The Value field in FloatData is still 
8 bytes. This means that the value field can store 8 bytes, but 
it can only read/write 4 bytes. It is up to the user to make sure 
that the value read or written does not exceed the 4 byte 
range.

sequence other array of Object
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Working with Sequences
Both bounded and unbounded sequences are mapped to the types indicated in Table 2. It 
is up to you to make sure that input parameters that are bounded sequences have the 
correct length.

Please note that both bounded and unbounded sequences are mapped to the types 
indicated in Table 1. It is up to you to make sure that input parameters that are bounded 
sequences have the correct length.

Table 2 Mapping of Sequences

IDL Type TOOL Type Discussion

sequence string array of TextData

sequence [unsigned] long array of IntegerData

sequence [unsigned] short array of ShortData The ShortData class is a new TOOL class. It is a subclass of 
IntegerData, and differs from this class only in that it is 
serialized as a 2-byte integer. The Value field in ShortData 
is still 4 bytes. This means that the value field can store 4 
bytes, but it can only read/write 2 bytes. It is up to the 
user to make sure that the value read or written does not 
exceed the 2 byte range.

sequence char BinaryData Each element of the sequence char/octet/boolean type is 
mapped to BinaryData byte. This mapping is more 
efficient and incurs less overhead than mapping these 
sequences into TOOL arrays. In addition, the BinaryData 
class provides a wealth of methods for data manipulation.

sequence octet BinaryData

sequence boolean array of BooleanData

sequence double array of DoubleData

sequence float array of FloatData The FloatData class is a new TOOL class. It is a subclass of 
DoubleData, and differs from this class only in that it is 
serialized as a 4-byte float. The Value field in FloatData is 
still 8 bytes. This means that the value field can store 8 
bytes, but it can only read/write 4 bytes. It is up to the 
user to make sure that the value read or written does not 
exceed the 4 byte range.

sequence other array of Object
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Working With Unions
An IDL union is translated into a TOOL class of the same name. All classes that have been 
created from an IDL union share the following method and virtual attributes:

Example Here is an example of an IDL union. 

This union is translated into a TOOL class with the name my_union that has the following 
virtual attributes and methods:

■ Virtual attributes: short_value, long_value, and def_value. 

Setting any of these virtual attributes, automatically sets the discriminator to the 
corresponding value. If you try to get any of the attributes when the union is not 
initialized or when it is set to a different case, will result in a Corba.BAD_OPERATION 
exception. Passing an uninitialized union to a CORBA call will also result in an 
exception. 

■ Methods: set_def_value

This is the same as the def_value attribute, except that it allows you to set the 
discriminator to a given value, whereas using the def_value attribute picks an arbitrary 
value. Passing a discriminator that corresponds to any of the explicitly stated cases will 
result in a Corba.BAD_OPERATION exception.

Name Kind Description

clear_union method After this call, the value of the union is cleared and the 
union is no longer initialized.

discriminator virtual attribute A read-only field that specifies which case of the union is set. 
The return value depends on the switch case specified in the 
IDL declaration.

is_initialized virtual attribute TRUE if the value of the union has been set; FALSE if it has 
not been set or if the clear_union method has been called.

is_default virtual attribute TRUE if the discriminator is not set to one of the explicit 
cases listed in the IDL declaration.

With reference to the example below, the is_default 
attribute would return TRUE if the discriminator is set to any 
value other than 1 or 2. 

union my_union switch(long)

{

case1:

short short_value;

case2:

long long_value;

case3:

float def_value;

};
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TOOL to IDL Mapping
The following sections describe how parameter, return values, and exceptions are 
translated into IDL.

Parameter and Return Values
Corbagen generates IDL only for methods that have parameters and return values of the 
following supported classes and data types (described in the sections that follow):

■ portable scalar values (For more information, see “Portable Scalar Values” below)

■ DataValue subclasses (page 64)

■ the Forte classes Object and GenericException and its subclasses (page 65)

■ distributed objects (page 65)

■ CorbaFlat objects (page 65)

■ Structs (page 67)

■ Arrays (page 67)

Additional restrictions There are additional restrictions on generating IDL:

■ Forte does not generate IDL for overloaded methods.

■ You can pass structs from clients to Forte distributed objects, and the reverse. If the 
client passes a struct as an input parameter to a method of a Forte distributed object, 
that struct exists only for the duration of the method call. At the end of the method call, 
Forte deallocates the memory for the struct in the Forte partition. 

If you want to access the struct after the method completes execution, the method must 
explicitly allocate memory for the data and copy the struct into that memory.

Writing wrapper methods If a method has parameters and return values that do not conform to these types and 
guidelines, no IDL is generated for that method. However, you can write a wrapper method 
for it.

For example, if a class provides overloaded methods, you can write a wrapper method that 
defines a unique method signature for each of the overloaded methods. Forte can then 
generate IDL for these wrapper methods.

Portable Scalar Values
Forte performs the following mapping between TOOL portable scalar data types and IDL:  

TOOL Scalar Data Type IDL Equivalent

boolean boolean

double double

float float

i2 short

i4 long

integer long

string string

ui2 unsigned short

ui4 unsigned long
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Note Forte does not produce IDL for methods that have parameters or return values with data 
types that are not portable across different platforms, such as the TOOL data types int, 
long, or short.

Forte Framework Library DataValue Subclasses
The following table lists the DataValue subclasses that are supported and the IDL that is 
generated for each: 

The ImageData, ImageNullable, and IntervalData subclasses of DataValue are not 
supported.

Objects of the DataValue subclasses shown in the table above are automatically converted 
to the scalar data types or structs when they are passed to the client, and converted from 
these structs or scalars to an object with the correct data type when they are received from 
clients.

If you pass a NIL for parameters that are DataValue subclasses, the client receives a struct 
of binary zeros.

Supported Forte DataValue Subclass IDL Equivalent

BinaryData sequence<octet>

BinaryNullable struct BinaryNullable_struc{
boolean nullind;
BinaryData value;  (Note: resolves to a sequence<octet>.)
}

BooleanData boolean

BooleanNullable struct BooleanNullable_struc{
boolean nullind;
boolean value;

}

DateTimeData string

DateTimeNullable struct DateTimeNullable_struc{
boolean nullind;
string value;

}

DecimalData string

DecimalNullable struct DecimalNullable_struc{
boolean nullind;
string value;

}

DoubleData double

DoubleNullable struct DoubleNullable_struc{
boolean nullind;
double value;

}

IntegerData long

IntegerNullable struct IntegerNullable_struc{
boolean nullind;
long value;

}

TextData string

TextNullable struct TextNullable_struc{
boolean nullind;
string value;

}
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The Object Class and GenericException and Its Subclasses
Forte generates special IDL for the following classes: 

For more information about how Forte maps exceptions to the generated GenericException 
class, see “Working with Exceptions” on page 68.

Distributed Objects 
Methods returning references to unanchored objects or returning copies of distributed 
objects (except for the DataValue subclasses described previously on page 64), do not have 
corresponding IDL generated for them.

CorbaFlat Objects
You can send or receive a Forte non-distributed object as a parameter. This object is 
converted to a CORBA struct, or “flattened” in the IDL file. This struct includes all the 
attributes defined in the object’s class. 

To enable a nondistributed object to be translated into a struct and sent as a parameter, 
you must specify the CorbaFlat extended property in the class definition. If you use the 
CorbaFlat extended property, the distributed property must not be specified as allowed or 
default.

You can also specify the CorbaFlat extended property in the Forte Workshops in the 
Extended Properties dialog. In the Project Workshop select the class, then choose the 
Component > Extended Properties command.

TOOL Class IDL Equivalent

Object ForteObject

Any subclass of 
GenericException

GenericException

class MyClass inherits Object

. . .

-- methods and attributes here

. . . 

has property extended=(CorbaFlat);
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For example, the BankAccount class has the following class statement: 

The IDL generated for this flattened class is as follows: 

Restrictions for Flattened 
Objects

A class that is to be translated into a Corba struct (flattened) cannot have any attributes 
whose type is also that class. For example, the following class definition cannot be flattened 
because the attribute Brother is of the type Child, which is the class itself: 

Similarly, a class that is to be flattened cannot have any attributes of a type that is a class 
that has any attributes whose type is the class to be flattened. In the following example, the 
class definitions cannot be flattened because the attribute Parent in class Child is of the 
type Adult, while the class Adult also has an attribute Offspring that is of type Child: 

In either of these cases, Forte generates the exception DistributedAccessException at 
runtime. 

begin CLASS;

class BankAccount inherits from Framework.Object

has public  attribute AcctBalance: Framework.double;

has public  attribute AcctName: Framework.TextData;

has public  attribute AcctNumber: Framework.integer;

has public  method Init;

has property

shared=(allow=off, override=on);

transactional=(allow=off, override=on);

monitored=(allow=off, override=on);

distributed=(allow=off, override=on);

extended = (CorbaFlat);

end class;

typedef struct BankAccount_struct

{

double AcctBalance;

Framework::TextData AcctName;

integer AcctNumber;

} BankAccount;

class Child inherits Object

Brother : Child; -- The type is the class Child.

has property extended=(CorbaFlat);

end class;

forward Adult;

class Child inherits Object

Parent : Adult; -- The type is the class Adult.

has property extended=(CorbaFlat);

end class;

class Adult inherits Object

Offspring : Child; -- The type is the class Child;

has property extended=(CorbaFlat);

end class;
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Structs
Forte generates CORBA structs that represent Forte structs (described in Integrating with 
External Systems).

Arrays
Forte automatically generates IDL for methods that use parameters with an Array data type 
and for attributes that have an Array data type that is a distributed object reference 
(page 65) or a flattened object (page 65), or that is one of the supported DataValue 
subclasses (page 64). This generated IDL is a sequence rather than an IDL Array.

Parameters and attributes that have an Array data type must also refer to the class type of 
the objects in the array. For example, an attribute with the data type Array of TextData will 
be included in the IDL output as a sequence. However, an attribute with the data type Array 
will not be included.

The following example shows the TOOL code for an attribute in the BankServices class that 
has an Array data type: 

The following example shows how the BankServices.AcctList attribute is expressed in the 
generated IDL file:

has public attribute AcctList: Array of BankServices.BankAccount;

attribute BankServices::sequence_BankAccount AcctList;
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Working with Exceptions
When Forte generates IDL for a method that raises an exception, the IDL equivalent of the 
method signature by default raises one of two IIOP exceptions: either GenericException or 
UserException. 

You can specify which throws clause will be exported to IDL by setting any of the following 
three extended properties (for a description of how to set an extended property on a class, 
see “CorbaFlat Objects” on page 65):

DefaultThrowsClause This property is set at the project level and controls the default 
throws clause in the IDL output (determines which exceptions are thrown) for every 
method in the project. By default the clause specifies GenericException and 
UsageException, as follows:

ThrowsClause This clause is set at a method level and overrides the default clause or, if it 
is set, the DefaultThrowsClause.

IsThrowable This property is set on a class that you want to export to IDL as an 
exception. The class must not be distributed.

ErrorDesc_struct A Forte exception class when translated into IDL contains an ErrorDesc_struct that is 
defined in the framewor.idl file. This ErrorDesc_struct contains the data in the attributes of 
the Framework ErrorDesc class. An client must be able to respond to exceptions when they 
are raised by a Forte method. Ensure that the exceptions raised by a Forte method define 
appropriate information in the following attributes of the raised TOOL exception:

For a description of how an client interprets this information, see “Interpreting Exception 
Information” on page 47.

For more information about raising exceptions, see the TOOL Reference Manual and the 
Framework Library online Help.

(Framework::GenericException, Framework::UsageException)

Attribute Description

Message Message text for the exception.

ReasonCode Code indicating the cause of the exception.

Severity Code indicating the severity of the exception.

SetNumber Number indicating the message set containing the message associated with this exception.

MsgNumber Number of the message in the message set associated with this exception.
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Configuration Parameters for a TOOL CORBA Object
This section describes how to use the configuration parameters of the Fscript 
SetServiceEOSInfo to set up Forte service objects to act as CORBA objects.

You can specify the following configuration parameters in the IIOP Configuration dialog or 
in the export_name argument of the Fscript SetServiceEOSInfo command for service 
objects that are CORBA objects:

■ Outbound (callout)

■ IORFile

■ ListenLocation (Location field in the Service Object Properties dialog)

■ Forward (Turn off the Redirect Request toggle in the Service Object Properties dialog)

■ Redirect (Turn on the Redirect Requests toggle in the Service Object Properties dialog)

■ Host 

■ Port

■ DisableAutoStartGW (Turn on the Disable Auto Start toggle in the Service Object 
Properties dialog)

■ IIOP mode

The default configuration parameters for a Forte service object that is a CORBA object are: 
“forward, listenlocation = here, inbound, generate=idl”

The syntax for the SetServiceEOSInfo Fscript command for a Forte service object that is a 
CORBA object is the following:

SetServiceEOSInfo service_object_name iiop 
“[outbound,] IORFile = (name=iorfile_name [, runtime | dist])
[, listenlocation = here | remote] [, forward | redirect]
[, host = host_name] [, port = port_number] [, disableautostartgw]

service_object_name is the name of the service object that you want to make available to 
CORBA clients. If the current project contains the service object, you can specify just the 
name of the service object; otherwise, service_object_name should specify the project 
name and the service object name, separated by a period.

The details of the configuration parameters specified in the quotation marks are described 
in the following sections.

Outbound Parameter
By default, Forte 4GL makes the service object an IIOP server. Unless you want the service 
object to become a CORBA client that sends requests to (does callout to) a CORBA server, 
specify this parameter.
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IORFile Parameter
The IORFile parameter specifies that the runtime system write an IOR (Internet Object 
Reference) string in a file for this service object. This parameter specifies when the file is 
written and the name of the file. 

A CORBA client uses the information in the IOR string to determine the location of a 
listener (using the specified host and port). The client then sends requests to that listener, 
which in turn routes the requests to the partition containing the service object. 

Specify unique
names and paths

If you have multiple service objects generating IOR files, you must specify a unique path 
and file name for the name parameter of the IORFile parameter; otherwise, the IOR files 
will overwrite each other.

You can specify this configuration parameter with the SetServiceEOSInfo command or in 
the IIOP Configuration dialog :

IORFile = (runtime | distribution, name=iorfile_name) 

If you specify only the name parameter or only the runtime or distribution option for IOR 
file keywords, you do not need to use parentheses around the IORFile parameter value. For 
example, you can specify IORFile=runtime, if you also specify IORFile=name=myfile.ior on 
the same command, as shown:

ListenLocation Parameter
The listenlocation parameter specifies whether the CORBA client uses a listener on the 
same partition as the service object, or a listener on a remote partition or gateway.

You can specify this configuration parameter in one of the following ways, as part of the 
SetServiceEOSInfo command’s export_name value or in the IIOP Configuration dialog:

listenlocation = here | remote 

Parameter name or keyword Description

runtime Generates this file when the partition containing the service object starts. 
runtime and distribution are mutually exclusive keywords.

distribution Generates this file when the application distribution for the partition containing 
the service object is generated. runtime and distribution are mutually 
exclusive keywords.

name=iorfile_name Specifies the name of the IOR file in local format. If the file name is relative, the 
file is created in the $FORTE_ROOT/etc/iiopior directory. If the file name is 
absolute, the file is created with the specified local file name.

On one line: fscript> SetServiceEOSInfo myServer iiop “Forward, IORFile=runtime,

ListenLocation=here, IORFile=name=myserv.ior”

Parameter name or keyword Description

here CORBA clients use a listener on the same partition. here and remote are 
mutually exclusive. here is the default.

remote CORBA clients use a listener on remote partition or an IIOP gateway. 

here and remote are mutually exclusive. 
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IIOP gateway If you want to have a listener run in a separate partition from your application, you can set 
up an application referred to as the IIOP gateway. The IIOP gateway is an application 
provided by Forte 4GL that is named iiopgw. The application starts a listener. 

When you specify the remote keyword for the listenlocation parameter, the CORBA client 
can use a listener belonging to the IIOP gateway application on the specified host. If no 
listener is running at the specified port on the specified host and the IIOP gateway is 
installed on that machine, Forte automatically starts the IIOP gateway. You can specify the 
DisableAutoStartGW keyword (described in “Disableautostartgw Parameter” on page 74) 
to prevent Forte from automatically starting the IIOP gateway this way.

The most common reason to use the IIOP gateway application is to provide a single 
external listener for all CORBA clients. You can install an IIOP gateway application on a 
particular machine and have service objects specify the listenlocation=remote parameter 
and the host name and port number of the listener started by the IIOP gateway. 

Forward Parameter
The forward keyword specifies that the listener route each request to the partition 
containing the appropriate distributed object. The listener routes the requests to other 
Forte partitions, as necessary. The forward and redirect keywords are mutually exclusive, 
and forward is the default

You can specify forward or redirect to improve the performance of the client interaction 
with the Forte application and to work with Java security.

redirect can improve 
performance

If your IIOP client application frequently references TOOL distributed objects that are on 
different partitions than the listener or listeners that it uses, you can specify the redirect 
keyword to reduce the amount of time required for a request to reach the intended Forte 
object. After the first request, the client sends all subsequent requests directly to a listener 
on the correct partition instead of sending them to the original listener.

Setting the mode for a Web 
server with Java security

If the listener for the Forte application is on a Web server that uses Java security, Java 
security prevents the IIOP client from directly accessing partitions running on other 
machines. You should consider the following options when deciding how to set the routing 
mode:

■ If you specify the redirect keyword, all the partitions that you want IIOP clients to access 
must be placed on the same machine as the Web server to ensure that the IIOP clients 
can access all the partitions they need to.

■ If you specify the forward keyword, the partitions that you want IIOP clients to access 
can be on different machines from the Web server. You can have IIOP clients access a 
single listener that resides on the Web server machine, perhaps a listener started by an 
IIOP gateway. Forte then routes the requests to the other Forte partitions.
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Redirect Parameter
The redirect parameter specifies that the CORBA client be informed of the location of the 
distributed object, after which the client sends requests directly to a listener on the same 
partition as the distributed object instead of routing all requests though the original 
listener. The forward and redirect parameters are mutually exclusive.

The listener tells the CORBA client to send the request again to the listener on the same 
partition as the appropriate Forte object. If there is no listener running on that partition, 
this option automatically starts a listener for that object. The client then sends all 
subsequent requests for this Forte object directly to the partition containing the object.

The CORBA client cannot failover to other service objects in this mode. 

Host Parameter
The host parameter specifies the TCP name (or the IP address) of the host machine on 
which the listener is running. This host name is included in the IOR file, so the IIOP client 
will send requests to that host.

You can only specify a host name if the listener location is Remote. 

If the IOR file is to be created at distribution time, and you do not specify a host name, then 
the name of the host on which the application distribution is made is put into the IOR file.

If the IOR is to be created at runtime, and you do not specify a host name, the name of the 
host on which the partition containing the service object is running is placed in the IOR 
file.

Port Parameter
The port parameter specifies the port number for a listener to which the CORBA client can 
send requests. The port location is included in the generated IOR file, so the client will send 
requests to that port number.

You must specify a port number when the IOR file is created at distribution time or if you 
have specified a remote listener.

If you do not specify a port number when the listener is here and the IOR file is generated 
at runtime, the operating system assigns a port number at runtime, and Forte includes that 
port number in the IOR file.
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Disableautostartgw Parameter
The disableautostartgw keyword prevents Forte from automatically trying to start a 
gateway. You can only use this keyword with a remote listener (listenlocation=remote). If 
you do not specify this keyword, Forte automatically tries to start the IIOP gateway 
application if a listener is not running where a service object expects one. If the IIOP 
gateway application is not installed on a node where Forte tries to start it, Forte raises a 
DistributedAccessException.
Forte 4GL Java Interoperability Guide



Index
A
AlreadyBound exception 18

Anchored object
IIOP clients, accessing 30, 47

Arrays 67

Auto-start, IIOP Gateway, preventing 25

B
BAD_OPERATION exception 17

BAD_PARAM exception 17

BinaryData class 64

BinaryNullable class 64

Binding class 18

BindingIterator class 18

BooleanData class 64

BooleanNullable class 64

boolean scalar data type 63

C
CannotProceed exception 18

Client stubs, generating from IDL 45

command syntax conventions 9

configuration parameters, IIOP servers 70

configuring listeners 20

CORBA
4GL support 17
architecture 14
interface specification 17
naming service 16
overview 13

corba#.idl file 37

CorbaFlat extended property 65

Corbagen 17

CORBA library 17

CorbaObjectImpl 17

CorbaObject interface 17

CosNaming interface specification 17

CosNaming library 17

D
data type mapping 63, 64, 65

DateTimeData class 64

DateTimeNullable class 64

DecimalData class 64

DecimalNullable class 64

DefaultThrowsClause 68

Disable Auto Start 35

DisableAutoStartGW setting 25, 74

display library 45

displayp.idl file 45

DistributedAccessException
CorbaFlat objects, and 66
IIOP gateway not installed 25

Distributed class property 30

Distributed object
accessing 30
accessing by clients 46
disconnecting from 47
IIOP clients, accessing 46
IIOP-IDL 65

distribution, making
IIOP-IDL clients 57
IIOP-IDL server 37



76 Section E
Distribution option, IOR file 35
SetServiceEOSInfo Fscript command 71

documenting IIOP-IDL servers 38

DoubleData class 64

DoubleNullable class 64

double scalar data type 63

E
ErrorDesc_struct 47

Exceptions 68
DefaultThrowsClause, IDL 68
Generic Exception class, IDL 65
IIOP client, returned to 47
IsThrowable, IDL settings 68
ThrowsClause, IDL settings 68

Extended properties
DefaultThrowsClause 68
IsThrowable, IDL settings 68
ThrowsClause, IDL settings 68

F
Failover for listeners 23

Flattened object, mapping to IDL 65

float scalar data type 63

Forte IIOP server 20

Forte service object, See Service object

Forward mode 21
IIOP-IDL servers, setting 35
service object, single listener 21
SetServiceEOSInfo Fscript command 72

framewor.idl file 45

Framework library, IDL file 45

Fscript SetServiceEOSInfo command 36

G
genericd.idl file 45

GenericDBMS library 45

GenericException 68
Forte class, IDL generated 65
IIOP client, returned to 47
IIOP-IDL client 68

H
Here option

IIOP-IDL servers 35
service object, single listener 21
SetServiceEOSInfo Fscript command 71

Host
listener, specifying 36
SetServiceEOSInfo Fscript command 73

I
i2 scalar data type 63

i4 scalar data type 63

IDL
data types 63, 64
file 14
generating overloaded methods, and 63
generating restrictions 63
generating wrapper methods 63
interface 14
mapping to TOOL 60
skeleton file 14
stub file 14
Unanchored objects, and 65

IDL file
anchored objects, and 30
generating client stubs 45

IDL skeleton 15

IDL stub 15

IIOP_IDL server
ListenLocation parameter 71

IIOP client
creating 45
exceptions, Forte, interpreting 47
IOR file, reading 46
running 48

IIOPConfigDialogSettings 35

IIOP Configuration dialog 34
IIOP-IDL servers 35
IORFile parameter 70, 71
ListenLocation parameter 71

IIOP configuration parameters 70

IIOP gateway 24
auto-start, disabling 74
auto-start, IIOP-IDL servers 35
configuration parameters 25
installing 24
multiple servers, example 26
starting 25
with remote listener 72
Forte 4GL Java Interoperability Guide



77Section J
IIOP Gateway, preventing auto-start 25

IIOP-IDL
Iona OrbixWeb 18
Visigenic VisiBroker 18

IIOP-IDL client
creating Java 49
creating TOOL 53
files needed by 44
generating stubs 45
implementing Java 50
implementing TOOL 54
installing 57
making distribution 57
running 48
testing 57

IIOP-IDL server
configuring 34
corba#.idl file 37
designing TOOL 18
documenting 38
IIOP client, running with 48
IIOP clients of, creating 45
installing 38
IOR file, settings 35
Java 39
making distribution 37
SetServiceEOSInfo command 36
testing 37
TOOL 31, 32
unanchored class 30

installing
IIOP gateway 24
IIOP-IDL clients 57
IIOP-IDL servers 38

IntegerData class 64

IntegerNullable class 64

integer scalar data type 63

InvalidName exception 17, 18

Iona OrbixWeb 18

IOR file
automatic generation 44
failover, and 23
Forte IIOP server, specifying for 70
generation 35
getting object reference 51, 56
IIOP clients, reading 46
IIOP-IDL server 35
introduced 15
passing object reference 34, 41
reading 46
specifying for a Forte IIOP server 71

IORFile parameter
Forte IIOP server 70

IOR string 15

IsAnchored class property 30

IsThrowable 68

J
Java security

IIOP Gateway, and 20
multiple servers, example 26
multiple servers, supporting 24
setting routing mode 72

L
libraries

CORBA 17
CosNaming 17

Listener
configurations 20
failover 23
Here option, specifying 35
IIOP-IDL servers 36
load balancing 23
one for a Forte environment 21
one for multiple service objects 21
one only 21
one per service object 21
partition, separate 20
port, specifying 36
redirecting requests 22
remote option 22
Remote option, specifying 35
setting locations 71
settings 35

load balancing service objects 23

M
making distribution

IIOP-IDL clients 57
IIOP-IDL server 37

multiple servers
IIOP gateway, and 24
IIOP gateway, example 26
Index



78 Section N
N
NameComponent class 18

name parameter, IORFile settings 71

NamingContext class 18

naming service
getting object reference 56
introduced 16
starting 52, 57
using 46

NotEmpty exception 18

NotFound exception 18

O
Object class 65

Object implementation 14

Object reference 14, 15

ORB
class 17
initializing 51, 56
introduced 15

Overloaded methods
generating IDL, and 63

P
Partition

IIOP Gateway, and 20
remote option 22

partitioning
failover, and 23
load balancing, and 23

PDF files, viewing and searching 12

Port
IIOP gateway 25
listener, specifying 36, 73

Port option 73

Port parameter 73

Properties
IIOP-IDL 65
IsThrowable 68
project, IIOP-IDL 68

R
Redirect keyword 73

Redirect mode
IIOP-IDL servers, setting 35
SetServiceEOSInfo command, setting with 73

Remote keyword 71

Remote option
failover, and 23
IIOP-IDL servers 35
service object 22
SetServiceEOSInfo command, setting with 71

Runtime keyword 71

Runtime option, IOR file
IIOP-IDL server 35
SetServiceEOSInfo command, setting with 71

S
scalar data type 63

scalar values, portable 63

Sequences 61

Service object
exception information 68
failover 23
forward mode 21
here option 21, 35
IIOP-IDL server 36
IIOP-IDL servers 34
IIOP-IDL settings 34
listener, single per 21
load balancing 23
one listener for all 21
remote option 22
SetServiceEOSInfo Fscript command 70

Service Object Properties dialog 34

SetServiceEOSInfo command 73
DisableAutoStartGW keyword 74
Forward keyword 72
IIOP-IDL servers 36
IORFile parameter 70, 71
ListenLocation parameter 71
Port option 73
Port parameter 73
Redirect keyword 73
Forte 4GL Java Interoperability Guide



79Section T
Starting IIOP gateway 25

string scalar data type 63

Struct, Corba, Forte-generated 67

Stubs 45

systemmo.idl file 45

SystemMonitor library 45

T
Technical Notes

Iona OrbixWeb 18
Visigenic VisiBroker 18

testing
IIOP-IDL clients 57
IIOP-IDL servers 37

TextData class 64

TextNullable class 64

ThrowsClause, IDL settings 68

TOOL code conventions 9

U
ui2 scalar data type 63

ui4 scalar data type 63

Unanchored class 30

Unanchored object
IDL, and 65
mapping to IDL 65

unions 62

UserException 68

V
Visigenic VisiBroker 18

W
Web server 24, 26

Wrapper methods 63
Index



80 Section W
Forte 4GL Java Interoperability Guide


	Contents
	Preface
	Organization of This Manual
	Conventions
	Command Syntax Conventions
	TOOL Code Conventions

	The Forte Documentation Set
	Forte 4GL
	Forte Express
	Forte WebEnterprise and WebEnterprise Designer

	Forte Example Programs
	Viewing and Searching PDF Files

	Interoperating With CORBA Objects
	Overview
	CORBA Architecture and Concepts
	Basic Concepts
	Architecture
	Getting an Object Reference
	Naming Service

	CORBA Support
	The TOOL Corba Library
	The CosNaming Library
	Using ORB Development Tools


	TOOL Server Design
	Listener and Service Object Configurations
	One Listener Per Service Object, Same Partition
	Forward Mode
	Redirect Mode
	Load Balancing
	Failover

	Using the Forte IIOP Gateway
	Installing the IIOP Gateway Application
	Starting the IIOP Gateway
	Setting Up for Automatic Startup of the IIOP Gateway
	Starting an IIOP Gateway Manually
	Configuring a Service Object to Use the IIOP Gateway


	Building a CORBA-Enabled Application
	Create the IDL Interface Definition
	Implement the Client
	Implement the Server
	Build and Run the Application


	CORBA Servers
	Servers
	Accessing Distributed Objects
	TOOL Servers

	Working with TOOL Servers
	Implementing the TOOL Server
	Using an IOR File to Pass an Object Reference
	Specifying that a Service Object Is a CORBA Server

	Testing, Making the Distribution, and Installing
	Testing Your Application
	Making a Distribution
	Installing the Forte Application

	Documenting the IIOP server

	Working with Java Servers
	Implementing the Server
	Using an IOR file to Pass an Object Reference
	Building the Server


	Working with CORBA Clients
	Client Overview
	Files Needed by IIOP Clients
	Locating TOOL IDL files

	Generating Client Stubs from IDL
	Writing an IIOP Client Application
	Using the Naming Service
	Reading the IOR File
	Accessing Distributed Objects
	Interpreting Exception Information

	Running a Client Application

	Working with Java Clients
	Compiling the IDL File
	Creating a Java Client
	Compile the IDL Interface File
	Implementing the Java Client
	Initializing the ORB
	Getting an Object Reference from the Naming Service
	Getting an Object Reference from an IOR File

	Starting the Naming Service
	Building the Client

	Working With TOOL Clients
	Compiling the IDL File
	Creating a TOOL Client
	Implementing the TOOL Client
	Initializing the ORB
	Getting an Object reference from the Naming Service
	Getting an Object Reference from an IOR File

	Starting the Naming Service
	Testing, Making a Distribution, and Installing the TOOL Client
	Testing Your Application
	Making a Distribution and Installing Your Application



	IDL and TOOL
	IDL to TOOL Mappings
	Working with Sequences
	Working With Unions

	TOOL to IDL Mapping
	Parameter and Return Values
	Portable Scalar Values
	Forte Framework Library DataValue Subclasses
	The Object Class and GenericException and Its Subclasses
	Distributed Objects
	CorbaFlat Objects
	Structs
	Arrays

	Working with Exceptions


	Using Fscript to Configure CORBA Servers
	Configuration Parameters for a TOOL CORBA Object
	Outbound Parameter
	IORFile Parameter
	ListenLocation Parameter
	Forward Parameter
	Redirect Parameter
	Host Parameter
	Port Parameter
	Disableautostartgw Parameter


	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W


